Contents

1 Printer Information

User Safety ................................................................. 8
  Electrical Safety ...................................................... 8
  Laser Safety ............................................................ 9
  Maintenance Safety .................................................. 9
  Operational Safety .................................................. 9
  Moving the Printer .................................................. 12
  Safety Symbols Marked on Product .............................. 13

Printer Specifications ................................................ 14

Regulatory Information ................................................ 15
  United States (FCC Regulations) ................................. 15
  Canada (Regulations) ................................................ 15
  European Union ...................................................... 16

Material Safety Data Sheet ............................................ 17

Product Recycling and Disposal .................................... 18
  European Union ...................................................... 18
  North America ....................................................... 19
  Other Countries ..................................................... 19

2 Printer Features

Main Components and Their Functions ............................ 21
  Front View ............................................................ 21
  Rear View ............................................................ 22
  Internal View ........................................................ 22
  Options ............................................................... 24

Control Panel ........................................................... 25
  Control Panel Layout ................................................ 25
  Display ............................................................... 25
  Information Pages .................................................. 26

Power Saver Mode ....................................................... 27
  Exiting the Power Saver Mode .................................... 27

Checking Status of Print Data ....................................... 28
  Checking in Windows ................................................. 28

Displaying Optional Accessory Configuration and Paper Tray Settings .................................................. 29

More Information ...................................................... 30

Resources .............................................................. 30
3 Network Basics

Overview of Network Setup and Configuration .................................................. 32
Choosing a Connection Method ............................................................................. 33
   Connecting via Ethernet (Recommended) ......................................................... 33
   Connecting via USB ........................................................................................... 34
Configuring the Network Address ............................................................... 35
   TCP/IP and IP Addresses ................................................................................... 35
   Dynamic Methods of Setting the Printer’s IP Address ....................................... 36
   Manually Setting the Printer’s IP Address ......................................................... 37
Installing the Printer Drivers .............................................................................. 39
   Available Drivers .............................................................................................. 39
      Windows 2000 or Later ................................................................................... 40
      Macintosh OS X, Version 10.3 and Higher ..................................................... 41

4 Printing Basics

Supported Paper and Media .............................................................................. 46
   Paper Usage Guidelines ..................................................................................... 46
   Paper That Can Damage Your Printer .............................................................. 48
   Paper Storage Guidelines .................................................................................. 48
About Paper ............................................................................................................ 49
Setting Paper Types and Sizes .......................................................................... 51
   Setting Paper Trays ............................................................................................ 51
   Setting Paper Types ........................................................................................... 51
   Setting Paper Sizes ............................................................................................ 52
Loading Paper ....................................................................................................... 53
   Loading Paper in Tray 1 (MPT) ....................................................................... 53
   Loading Paper in Trays 2-3 ............................................................................... 56
Selecting Printing Options .................................................................................. 60
   Selecting Printing Preferences (Windows) ......................................................... 60
   Selecting Options for an Individual Job (Windows) ............................................. 61
   Selecting Options for an Individual Job (Macintosh) ......................................... 63
Printing on Both Sides of the Paper ............................................................... 66
   Automatic 2-Sided Printing Guidelines ............................................................ 66
   Binding Edge Options ....................................................................................... 67
   Selecting 2-Sided Printing ............................................................................... 67
Phaser® 6280 Printer

Contents

Printing on Specialty Media ................................................................. 68
  Printing Transparencies ............................................................... 68
  Printing Envelopes ................................................................. 70
  Printing Labels ............................................................................ 73
  Printing Glossy Paper ................................................................. 78

Printing Custom Size or Long Paper .................................................... 83
  Defining Custom Paper Sizes ....................................................... 83
  Printing on Custom Size Paper ..................................................... 84

Printing Confidential Documents - Secure Print ..................................... 86
  About Secure Print ....................................................................... 86
  Configuring Secure Print ............................................................ 86

Print After Checking Printing Result - Proof Print ................................. 88
  About Proof Print ....................................................................... 88
  Configuring Proof Print .............................................................. 88

5 Using the Control Panel Menus

Control Panel Menus ........................................................................ 91
  Menu Configuration ..................................................................... 91
  Changing Menu Settings ............................................................ 92

Description of Menu Items .................................................................. 93
  Tray Settings ............................................................................. 93
  Information Pages ..................................................................... 95
  Billing Meters .......................................................................... 96
  Admin Menu ............................................................................. 96

Menu List .......................................................................................... 105

6 Print Quality

Print-Quality Problems ....................................................................... 107

Color Registration ............................................................................ 111
  Automatic Color Registration Adjustment ................................... 111
  Manual Color Registration Adjustment ........................................ 111
  Enabling/Disabling Automatic Color Registration ......................... 113

Run Black ......................................................................................... 114
7 Troubleshooting

Paper Jams ........................................................................................................... 116
  Preventing and Clearing Paper Jams ................................................................. 116
  Paper Jams in Tray 1 (MPT) ............................................................................ 117
  Paper Jams in the Paper Tray ......................................................................... 120
  Paper Jams at the Fuser ................................................................................ 123
  When Long Paper Jams ............................................................................... 124
  Paper Jams at the Duplex Unit ...................................................................... 125
  Paper Jams in the Optional Sheet Feeder ..................................................... 127

Problems With the Printer .................................................................................. 131
  Enabling Options .......................................................................................... 134

Control Panel Error Messages ......................................................................... 135
  Messages About Supplies .............................................................................. 135
  Messages About the Printer and Other Items ........................................... 136

Getting Help ........................................................................................................ 139
  Control Panel Messages ............................................................................... 139
  PrintingScout Alerts .................................................................................... 139
  Online Support Assistant ............................................................................ 139
  Web Links ...................................................................................................... 140

8 Maintenance

Cleaning the Printer .......................................................................................... 142
  Cleaning the Exterior .................................................................................... 142
  Cleaning the Interior ...................................................................................... 142

Ordering Supplies ............................................................................................... 143
  Consumables ................................................................................................ 143
  Routine Maintenance Items .......................................................................... 143
  When to Order Supplies ............................................................................... 143
  Recycling Supplies ....................................................................................... 144

Managing the Printer .......................................................................................... 145
  Checking/Managing the Printer with CentreWare IS ................................ 145
  Checking Printer Status with PrintingScout ............................................. 145
  Checking Printer Status Through E-mail ................................................... 146

Checking Page Counts ...................................................................................... 149

Moving the Printer .............................................................................................. 150

Index
Printer Information

This chapter includes:

- User Safety on page 8
- Printer Specifications on page 14
- Regulatory Information on page 15
- Material Safety Data Sheet on page 17
- Product Recycling and Disposal on page 18
User Safety

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your printer.

Electrical Safety

- Use the power cord supplied with your printer.
- Plug the power cord directly into a properly grounded electrical outlet. Make sure each end of the cord is securely connected. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
- Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.
- Do not use an extension cord or power strip.
- Verify that the printer is plugged into an outlet that is capable of providing the correct voltage and power. Review the printer’s electrical specification with an electrician if necessary.

**Warning:** Avoid the potential of electrical shock by ensuring that the printer is properly grounded. Electrical products may be hazardous if misused.

- Do not place the printer in an area where people might step on the power cord.
- Do not place objects on the power cord.
- Do not block the ventilation openings. These openings are provided to prevent overheating of the printer.
- Do not drop paper clips or staples into the printer.

**Warning:** Do not push objects into slots or openings on the printer. Making contact with a voltage point or shorting out a part could result in fire or electrical shock.

If you notice unusual noises or odors:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative to correct the problem.

The power cord is attached to the printer as a plug-in device at the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

**Warning:** Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are specifically instructed to do so. Power should be OFF when performing these installations. Except for user-installable options, there are no parts that you can maintain or service behind these covers.
**User Safety**

**Note:** Leave the printer on for optimum performance; it does not pose a safety hazard. If however the printer will not be used over an extended period of time, it should be turned off and unplugged.

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

**Laser Safety**

With specific regard to lasers, this printer complies with laser product performance standards set by governmental, national, and international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous light because the beam is totally enclosed during all modes of customer operation and maintenance.

**Maintenance Safety**

- Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with your printer.
- Do not use aerosol cleaners. The use of supplies that are not approved may cause poor performance and could create a hazardous condition.
- Do not attempt to open, reuse, or burn any consumables or routine maintenance items. For information on Xerox supplies recycling programs, go to [www.xerox.com/gwq](http://www.xerox.com/gwq).

**Operational Safety**

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards. Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

**Printer Location**

Place the printer in a dust-free area within a temperature range of 41° F to 90° F (5° C to 32° C) and a relative humidity range of 15 percent to 85 percent.
Humidity should be 70 percent or below at 90° F, and temperature should be 82° F or below at 85 percent humidity.

**Note:** Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause condensation inside the machine, directly interfering with image transfer.

**Printer Clearance**

Place the printer in an area where there is adequate space for ventilation, operation, and servicing. The recommended minimal spacing is:

**Overhead Clearance:**
- 35 cm (13.8 in.) above the printer

**Total Height Requirements:**
- Printer: 47 cm (18.5 in.)
- Add 14 cm (5.5 in.) for the 550-Sheet Feeder.

**Other Clearances:**
- 13 cm (5 in.) behind the printer
- 60 cm (23.6 in.) in front of the printer
- 10 cm (3.9 in.) on the left side of the printer
- 10 cm (3.9 in.) on the right side of the printer

**Operational Guidelines**
- Do not block or cover the slots and openings on the printer. The printer may overheat without adequate ventilation.
- For optimum performance, use the printer at elevations below 3,500 m (11,480 ft.).
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight to avoid exposing light-sensitive components when the doors are open.
- Do not place the printer in line with the cold air flow from an air conditioning system.
• Place the printer on a level, solid non-vibrating surface with adequate strength for the weight of the printer. It should be within 1° of horizontal with all four feet in solid contact with the surface. The printer weight with the duplex unit and consumables is 29.25 kg (64.5 lb.).
• Do not place the printer in locations exposed to magnetic forces.
• Do not place the printer in damp locations.
• Do not place the printer in locations susceptible to vibrations.

Printing Safety Guidelines
• Wait 10-15 seconds between turning the printer off and on.
• Keep hands, hair, neckties, etc., away from the exit and feed rollers.

When the printer is printing:
• Do not remove the paper source tray that you selected in either the printer driver or control panel.
• Do not open the doors.
• Do not move the printer.

Printer Supplies
• Use the supplies specifically designed for your printer. The use of unsuitable materials may cause poor performance and a possible safety hazard.
• Follow all warnings and instructions marked on, or supplied with, the printer, options, and supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreements, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside these areas; please contact your local representative for details.
Moving the Printer

Follow these guidelines to avoid injuring yourself or damaging the printer:

- Turn off the printer and unplug all power cables before moving the printer.

- Always use two people to lift the printer.
- Always lift the printer from the designated lift points.
• Carry the printer without tilting it.

  **Caution:** Do not tilt the printer more than 10 degrees to the front/back or right/left. Tilting more than 10 degrees may lead to consumables inside the printer spilling out.

  **Note:** The rear side of this printer is heavier than the front. Be aware of this weight difference when moving the printer.

• Do not place any food or liquids on the printer.

  **Caution:** Damage to the printer resulting from improper moving or failure to repackage the printer properly for shipment, is not covered by the warranty, service agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside these areas; please contact your local representative for details.

See also:
  - Moving the Printer on page 150

**Safety Symbols Marked on Product**

- Use caution (or draws attention to a particular component). See the manual(s) for information.

- Hot surface on or in the printer. Use caution to avoid personal injury.

- It may take 30 minutes for the fuser to cool down.

- Do not touch the item.
## Printer Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>400 (W) × 490 (D) × 473 (H) mm</td>
</tr>
<tr>
<td>Weight</td>
<td>Printer: 24.4 kg (54 lb.) including print cartridges</td>
</tr>
<tr>
<td></td>
<td>550 Sheet Feeder (optional): 7.9 kg (17.4 lb.)</td>
</tr>
<tr>
<td></td>
<td>Duplex Unit (optional): 1 kg (2.2 lb.)</td>
</tr>
<tr>
<td>Warm-up time</td>
<td>20 seconds or less (when power is switched on, temperature: 22°C)</td>
</tr>
<tr>
<td></td>
<td>However, the printer’s electrical system is ready 10 seconds after switching on the printer.</td>
</tr>
<tr>
<td>Continuous print speed *1</td>
<td>Color: 1 sided print: 25 sheets/min *2</td>
</tr>
<tr>
<td></td>
<td>2 sided print: 17 pages/min *3</td>
</tr>
<tr>
<td></td>
<td>Black-and-white: 1 sided print: 30 sheets/min *2</td>
</tr>
<tr>
<td></td>
<td>2 sided print: 20 pages/min *3</td>
</tr>
<tr>
<td><strong>Important</strong></td>
<td>*1 The print speed may decrease due to paper type, such as transparency or envelope: size, and printing conditions. The print speed may decrease due to image quality adjustment.</td>
</tr>
<tr>
<td></td>
<td>*2 Continuous print speed of documents that are all in A4.</td>
</tr>
<tr>
<td></td>
<td>*3 Continuous print speed of documents in A4.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Data processing resolution: 600 × 600 dpi (25.4 dots/mm): Multivalued</td>
</tr>
<tr>
<td></td>
<td>(25.4 dots/mm)</td>
</tr>
<tr>
<td></td>
<td>Output resolution: 600 dpi (25.4 dots/mm)</td>
</tr>
<tr>
<td>Power source</td>
<td>110-127 V~, 50/60 Hz, 8 A</td>
</tr>
<tr>
<td></td>
<td>220-240 V~, 50/60 Hz, 4 A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>AC 110 - 127 V:</td>
</tr>
<tr>
<td></td>
<td>Sleep Mode: 9 W or less</td>
</tr>
<tr>
<td></td>
<td>Standby: less than 95 W (fuser on),</td>
</tr>
<tr>
<td></td>
<td>Continuous color printing: less than 460 W,</td>
</tr>
<tr>
<td></td>
<td>Continuous monochrome printing: less than 460 W</td>
</tr>
<tr>
<td></td>
<td>AC 220 - 240 V:</td>
</tr>
<tr>
<td></td>
<td>Sleep Mode: 9 W or less</td>
</tr>
<tr>
<td></td>
<td>Standby: less than 95 W (fuser on),</td>
</tr>
<tr>
<td></td>
<td>Continuous color printing: less than 460 W,</td>
</tr>
<tr>
<td></td>
<td>Continuous monochrome printing: less than 460 W</td>
</tr>
<tr>
<td></td>
<td>This printer does not consume electric power when the power switch is turned off even if the printer is connected to an AC outlet.</td>
</tr>
<tr>
<td><strong>ENERGY STAR qualified printer:</strong></td>
<td>Default time to Power Saver is 30 minutes</td>
</tr>
<tr>
<td>*4 W = Watts.</td>
<td></td>
</tr>
</tbody>
</table>
Regulatory Information

This product has been tested to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this product in a typical office environment.

United States (FCC Regulations)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiver.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your reseller or an experienced radio/television technician for help.

Any changes or modifications not expressly approved by Xerox could void the user’s authority to operate the equipment. To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada (Regulations)

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
European Union

The CE mark applied to this product symbolizes Xerox’s declaration of conformity with the following applicable Directives of the European Union as of the dates indicated:

- December 12, 2006: Low Voltage Directive 2006/95/EC

This product, if used properly in accordance with the user’s instructions, is neither dangerous for the consumer nor for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this product can be obtained from Xerox.
Material Safety Data Sheet

For Material Safety Data information regarding your Phaser 6280 printer, go to:

- United States and Canada: www.xerox.com/msds
- European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/contacts.
Product Recycling and Disposal

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life takeback information.
**North America**

Xerox operates an equipment takeback and reuse/recycle program. Contact your Xerox sales representative (1-800-ASK-XEROX) to determine whether this Xerox product is part of the program. For more information about Xerox environmental programs, visit [www.xerox.com/environment](http://www.xerox.com/environment).

If you are managing the disposal of your Xerox product, please note that the product may contain, lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. In the United States, you may also refer to the Electronic Industries Alliance web site: [www.eiae.org](http://www.eiae.org). Perchlorate Material - This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see [www.dtsc.ca.gov/hazardouswaste/perchlorate](http://www.dtsc.ca.gov/hazardouswaste/perchlorate).

**Other Countries**

Please contact your local waste authorities and request disposal guidance.
This chapter includes:

- Main Components and Their Functions on page 21
- Control Panel on page 25
- Power Saver Mode on page 27
- Checking Status of Print Data on page 28
- Displaying Optional Accessory Configuration and Paper Tray Settings on page 29
- More Information on page 30
Main Components and Their Functions

This section includes:

- **Front View** on page 21
- **Rear View** on page 22
- **Internal View** on page 22

Front View

1. Front door A
2. Output tray
3. Control panel
4. Button A for opening the front door
5. Power switch
6. Tray 1 (MPT)
7. Tray 2
8. Tray 3 / 550 Sheet Feeder
Main Components and Their Functions

Rear View

1. Power cord connector
2. USB port
3. Network connector
4. Optional memory slot

Internal View

1. Fuser
2. Print cartridge
3. Transfer unit
4. Button A for opening the front door

1. Duplex unit
### Phaser 6280 Configurations

<table>
<thead>
<tr>
<th>Features</th>
<th>Printer Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>6280N</td>
</tr>
<tr>
<td>Memory Configuration*</td>
<td>256 MB</td>
</tr>
<tr>
<td>Print Speed (Color/Mono)</td>
<td>25/30</td>
</tr>
<tr>
<td>Letter</td>
<td>26/31</td>
</tr>
<tr>
<td>A4</td>
<td>25/30</td>
</tr>
<tr>
<td><strong>Resolutions (dpi)</strong></td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td>600 x 600 x 1 bit</td>
</tr>
<tr>
<td>Enhanced</td>
<td>600 x 600 x 4 bit</td>
</tr>
<tr>
<td>Ethernet Interface</td>
<td>10/100 Base-T</td>
</tr>
<tr>
<td>Tray 1 (MPT) (150 Sheet)</td>
<td>Standard</td>
</tr>
<tr>
<td>Tray 2 (250 Sheets)</td>
<td>Standard</td>
</tr>
<tr>
<td>550-Sheet Feeder</td>
<td>Optional</td>
</tr>
<tr>
<td>Duplex Unit</td>
<td>Optional</td>
</tr>
<tr>
<td>Wireless LAN</td>
<td>Optional</td>
</tr>
<tr>
<td><strong>Duplex</strong> (Color/Mono)</td>
<td></td>
</tr>
<tr>
<td>Letter</td>
<td>18/21</td>
</tr>
<tr>
<td>A4</td>
<td>17/20</td>
</tr>
</tbody>
</table>

* All configurations have one memory slot supporting 256 MB/512 MB/1024 MB DDR2 DIMMs, to a maximum of 1152 MB. Standard memories are soldered on board.
Options
You can order additional memory, trays, multi-protocol card, and a duplex unit if these items are not standard on your printer.

Memory
The printer features one slot that accepts 256, 512 or 1024 MB of DDR2 DIMMs.

Duplex Unit
The duplex unit enables 2-sided printing.

Additional Trays
- 550-Sheet Feeder (Tray 3)

Hard Drive
Use the hard drive for:
- Secure print (see Printing Confidential Documents - Secure Print on page 85)
- Proof print (see Print After Checking Printing Result - Proof Print on page 87)
- Saved printing
- Storing additional fonts and macros.
Control Panel

This section includes:

- Control Panel Layout on page 25
- Display on page 25
- Menu Map on page 26
- Information Pages on page 26

Control Panel Layout

1. Display indicates status messages, menus, and toner levels.
2. Menu button
   Scrolls to the menu operation. Switches the display between the menus and print screen.
3. OK button
   Sets the menu values. Also prints reports and lists.
4. Wake Up button
   This light is on in power saver mode. Push the button to exit power saver mode.
5. Cancel Job button
   Cancels the current print job.
6. Up Arrow button
   Scrolls upward through the menus.
   Down Arrow button
   Scrolls downward through the menus.
   Back Arrow button
   Scrolls backwards through the menus, or displays the Walk-Up Features menu.
   Forward Arrow button
   Scrolls forward through the menus.
7. Error
   The red light indicates an error condition.
8. Ready
   The green light indicates that the printer is ready to receive data from the computer. If the light is blinking, the printer is busy receiving data.

Display

There are two types of screens:

- Print screen (for displaying printer status)
- Menu screen (for configuring settings)
Information Pages

Your printer comes with a set of information pages to help you obtain the best results from your printer. Access these pages from the control panel. Print the Menu Map to see where these information pages are located in the control panel menu structure.

Menu Map

The Menu Map helps you navigate the control panel menus. To print the Menu Map:

1. On the control panel, press the Menu button, select Information Pages, and then press the OK button.
2. Select Menu Map, and then press the OK button to print.

Note: Print the Menu Map to see other information pages available for printing.

Configuration Page

To print the Configuration page to view current information about your printer, do the following:

1. On the control panel, press the Menu button, select Information Pages, and then press the OK button.
2. Select Configuration, and then press the OK button to print.

Demo Page

To print a demo page, do the following:

1. On the control panel, press the Menu button, select Information Pages, and then press the OK button.
2. Select Demo Pg, and then press the OK button to print.
Power Saver Mode

The printer is equipped with a Power Saver mode to reduce power consumption when it is left idle.

When no print data is received for 30 minutes (default), the printer will enter Power Saver mode.

The time ranges that can be specified for the printer to enter Power Saver mode are 5 to 60 minutes. Consumption of power during the Power Saver mode is 7 W or less and the time required to exit from Power Saver mode to a print-ready status is about 20 seconds.

See also:

Changing the Power Saver Time on page 92

Exiting the Power Saver Mode

The printer automatically cancels Power Saver mode once it receives data from the computer.

To cancel the Power Saver mode manually, press the Wake Up button.
Checking Status of Print Data

Checking in Windows

Printer information and status are displayed on the Status window. Double-click the PrintingScout printer icon on the task bar at the bottom right of the screen. From the displayed window, check the column Status.

You can change the display contents with the button on the left of the Printer Status window.

Status Setting button: Displays the Status Setting screen and allows you to check the printer name, printer connection port, and printer status.

For more information about PrintingScout, see the help:
1. From the Start menu, select Programs.
2. Select Xerox Office Printing.
3. Select PrintingScout.

Checking in CentreWare Internet Services

You can check the status of the print job sent to the printer at the Jobs tab of CentreWare Internet Services. To reach CentreWare Internet Services, see Starting CentreWare IS on page 145.
Displaying Optional Accessory Configuration and Paper Tray Settings

Print the Configuration page to view the current optional information about your printer, including duplex unit, hard drive, and paper trays:

1. On the control panel, press the Menu button, select Information Pages, and then press the OK button.
2. Select Configuration, and then press the OK button to print.
### More Information

Obtain information regarding your printer and its capabilities from the following sources.

## Resources

<table>
<thead>
<tr>
<th>Information</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Guide*</td>
<td>Packaged with printer</td>
</tr>
<tr>
<td>Quick Use Guide*</td>
<td>Packaged with printer</td>
</tr>
<tr>
<td>User Guide (PDF)*</td>
<td><em>Software and Documentation CD-ROM</em></td>
</tr>
<tr>
<td>Quick Start Tutorials (English only)</td>
<td><a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a></td>
</tr>
<tr>
<td>Video Tutorials</td>
<td><a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a></td>
</tr>
<tr>
<td>Recommended Media List</td>
<td>Recommended Media List (United States)</td>
</tr>
<tr>
<td></td>
<td>Recommended Media List (Europe)</td>
</tr>
<tr>
<td>Online Support Assistant</td>
<td><a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a></td>
</tr>
<tr>
<td>Technical Support</td>
<td><a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a></td>
</tr>
<tr>
<td>Information pages</td>
<td>Control panel menu</td>
</tr>
</tbody>
</table>

* Also available on the Support website.
Network Basics

This chapter includes:

- Overview of Network Setup and Configuration on page 32
- Choosing a Connection Method on page 33
- Configuring the Network Address on page 35
- Installing the Printer Drivers on page 39

This chapter provides basic information about setting up and connecting to your printer.

See also: (English Only)

Using CentreWare Internet Services tutorial www.office.xerox.com
Using the Windows Printer Driver tutorial www.office.xerox.com
Overview of Network Setup and Configuration

To set up and configure over the network:

1. Connect the printer to the network using the recommended hardware and cables.
2. Turn on the printer and the computer.
3. Print the Configuration page and keep it for referencing network settings.
4. Set the printer’s IP address. To do this, see Dynamic Methods of Setting the Printer’s IP Address on page 36.
5. Install the driver software on the computer from the Software and Documentation CD-ROM. For information on driver installation, see the section in this chapter for the specific operating system you are using.
6. Print a Configuration page to verify the new settings.

Note: If the Software and Documentation CD-ROM is not available, you can download the latest driver from www.xerox.com/drivers.
Choosing a Connection Method

Connect the printer via Ethernet or USB. A USB connection is a direct connection and is not used for networking. An Ethernet connection is used for networking. Hardware and cabling requirements vary for the different connection methods. Cabling and hardware are generally not included with your printer and must be purchased separately. This section includes:

- Connecting via Ethernet (Recommended) on page 33
- Connecting via USB on page 34

Connecting via Ethernet (Recommended)

Ethernet can be used for one or more computers. It supports many printers and systems on an Ethernet network. An Ethernet connection is recommended because it is faster than a USB connection. It also allows you direct access to CentreWare Internet Services (IS). The CentreWare IS web interface enables you to manage, configure, and monitor networked printers from your desktop. To reach CentreWare Internet Services, see Starting CentreWare IS on page 145.

Network Connection

Depending on your particular setup, the following hardware and cabling is required for Ethernet.

- If you are connecting to one computer, an Ethernet RJ-45 crossover cable is required.
- If you are connecting to one or more computers with an Ethernet hub, or cable or DSL router, two or more twisted-pair (category 5/RJ-45) cables are required. (One cable for each device.)

If you are connecting to one or more computers with a hub, connect the computer to the hub with one cable, and then connect the printer to the hub with the second cable. Connect to any port on the hub except the uplink port.

See also:

- Configuring the Network Address on page 35
- Installing the Printer Drivers on page 39
Choosing a Connection Method

Connecting via USB

If you are connecting to one computer, a USB connection offers fast data speeds. A USB connection is not as fast as an Ethernet connection. To use USB, PC users must have Windows 2000/XP/Server 2003 or newer. Macintosh users must use Mac OS X, version 10.3 and higher.

USB Connection

A USB connection requires a standard A/B USB cable. This cable is not included with your printer and must be purchased separately. Verify that you are using the correct USB cable for your connection (2.0 for best results).

1. Connect one end of the USB cable to the printer and turn it on.
2. Connect the other end of the USB cable to the computer.

See also:

Installing the Printer Drivers on page 39
Configuring the Network Address

This section includes:

- TCP/IP and IP Addresses on page 35
- Dynamic Methods of Setting the Printer’s IP Address on page 36
- Manually Setting the Printer’s IP Address on page 37

TCP/IP and IP Addresses

If your computer is on a large network, contact your network administrator for the appropriate TCP/IP addresses and additional configuration information.

If you are creating your own small Local Area Network or connecting the printer directly to your computer using Ethernet, follow the procedure for automatically setting the printer’s Internet Protocol (IP) address.

PCs and printers primarily use TCP/IP protocols to communicate over an Ethernet network. With TCP/IP protocols, each printer and computer must have a unique IP address. It is important that the addresses are similar, but not the same; only the last digit needs to be different. For example, your printer can have the address 192.168.1.2 while your computer has the address 192.168.1.3. Another device can have the address 192.168.1.4.

Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to talk to a networked printer. For Mac OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP addresses.

Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically programs an IP address into every PC and printer on the network that is configured to use DHCP. A DHCP server is built into most cable and DSL routers. If you use a cable or DSL router, see your router’s documentation for information on IP addressing.

See also:

Online Support Assistant at www.xerox.com/office/6280support
Dynamic Methods of Setting the Printer’s IP Address

There are two protocols available for dynamically setting the printer’s IP address:

- DHCP (enabled by default on all Phaser printers)
- AutoIP

You can turn on/off both protocols using the control panel, or use CentreWare IS to turn on/off DHCP.

**Note:** You can view the printer’s IP address at any time. On the control panel, select Menu. Then select Information Pgs and press the OK button. Finally, select Configuration, and then press the OK button.

**Using the Control Panel**

To turn on/off either the DHCP or AutoIP protocol:

1. On the control panel, select the Menu button.
2. Select the Admin menu, and then press the OK button.
3. Select the Network Setup menu, and then press the OK button.
4. Select the TCP/IP menu, and then press the OK button.
5. Select IPv4, and then press the OK button.
6. Select Get IP Address, and then press the OK button.
7. Select DHCP, and then press the OK button.

**Using CentreWare IS**

To turn on/off the DHCP protocol:

1. Launch your web browser.
2. Enter the printer’s IP address in the browser’s Address field (http://xxx.xxx.xxx.xxx).
4. Select the Protocols folder on the left navigation panel.
5. Select TCP/IP.
6. In the Get IP Address field, select the DHCP/Autonet option.
7. Click the Save Changes button.
Manually Setting the Printer’s IP Address

**Note:** Verify that your computer has a properly configured IP address for your network. Contact your network administrator for more information.

If you are on a network without a DHCP server, or in an environment where the network administrator assigns printer IP addresses, you can use this method to manually set the IP address. Manually setting the IP address overrides DHCP and AutoIP. Alternatively, if you are in a small office with a single PC and use a dialup modem connection, you can manually set the IP address.

### Information Required for Manual IP Addressing

<table>
<thead>
<tr>
<th>Information</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Protocol (IP) address of the printer</td>
<td>Format is xxx.xxx.xxx.xxx, where xxx represents a decimal number from 0–255.</td>
</tr>
<tr>
<td>Network Mask</td>
<td>Get this information from your network administrator.</td>
</tr>
<tr>
<td>Default Router/Gateway address</td>
<td>Router address is required to communicate with the host device from anywhere other than the local network segment.</td>
</tr>
</tbody>
</table>
Using the Control Panel

To manually set the IP address:

1. On the control panel, select the Menu button.
2. Select the Admin menu, and then press the OK button.
3. Select the Network Setup menu, and then press the OK button.
4. Select the TCP/IP menu, and then press the OK button.
5. Select IPv4, and then press the OK button.
6. Select IP Address use the arrows to configure the IP values, and then press the OK button.

Changing or Modifying the IP Address Using CentreWare IS

CentreWare IS provides a simple interface that enables you to manage, configure, and monitor networked printers from your desktop using an embedded web server. For complete information about CentreWare IS, click the Help button in CentreWare IS to go to the CentreWare IS Online Help.

After setting the printer’s IP address, you can modify TCP/IP settings using CentreWare IS.

1. Launch your web browser.
2. Enter the printer’s IP address in the browser’s Address field (http://xxx.xxx.xxx.xxx).
3. Click Properties.
4. Select the Protocols folder on the left sidebar.
5. Select TCP/IP.
6. Enter or modify the settings, and then click Save Changes at the bottom of the page.

Your printer reboots. Now use the new IP address to reach CWIS.
Installing the Printer Drivers

This section includes:

- Available Drivers on page 39
- Windows 2000 or Later on page 40
- Macintosh OS X, Version 10.3 and Higher on page 41

Available Drivers

To access special printing options, use a Xerox printer driver.

Xerox provides drivers for a variety of page description languages and operating systems. The following printer drivers are available:

<table>
<thead>
<tr>
<th>Printer Driver</th>
<th>Source*</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows PostScript Driver (also used for Windows Vista)</td>
<td>CD-ROM and Web</td>
<td>The PostScript driver is recommended to take full advantage of your system’s custom features and genuine Adobe® PostScript®. (Default printer driver.)</td>
</tr>
<tr>
<td>PCL6</td>
<td>CD-ROM and Web</td>
<td>The Printer Command Language driver can be used for applications requiring PCL.</td>
</tr>
<tr>
<td>Mac OS X (version 10.3 and higher) Driver</td>
<td>CD-ROM and Web</td>
<td>This driver enables printing from a Mac OS X (version 10.3 and higher) operating system.</td>
</tr>
<tr>
<td>UNIX</td>
<td>Web only</td>
<td>This driver enables printing from a UNIX operating system.</td>
</tr>
<tr>
<td>Linux</td>
<td>CD-ROM</td>
<td>This driver enables printing from a Linux operating system.</td>
</tr>
</tbody>
</table>

* Go to www.xerox.com/drivers for the latest printer drivers.
Windows 2000 or Later

To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the computer’s CD-ROM drive. If the installer does not launch, do the following:
   a. Click Start, and then click Run.
   b. In the Run window, type: `<CD drive>\SETUP.EXE`.
2. Click the Language button, select your language, and click OK.
3. Select Install Printer Driver.
4. Click I Agree to accept the license agreement, and show the Xerox Print Driver Installation window.
5. Select the Phaser 6280 driver and click Install to show the Installation Options window.
6. Select either PostScript and/or PCL 6 and click OK.
7. Click Install to start the installation.
8. When the installation is complete, select any of the following from the Installation Status window:
   - Set Printer As Default
   - Print A Test Page
   - Share Printer
9. Click Finish.

Note: PrintingScout is a separate option from the printer driver. To install PrintingScout, click Install PrintingScout in the Software and Documentation CD-ROM. Then follow the wizard to complete installation.

See also:
   Online Support Assistant at www.xerox.com/office/6280support
Macintosh OS X, Version 10.3 and Higher

Set up your printer using Bonjour (Rendezvous), create a desktop USB connection, or use an LPD/LPR connection for Macintosh OS X, version 10.3 and higher.

Macintosh OS X, Version 10.3

Bonjour (Rendezvous) Connection

To install the printer driver from the Software and Documentation CD-ROM:
1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click the Phaser 6280 icon on your desktop, and then:
   a. Click Phaser 6280 Installer.
   b. Type your password, and click OK.
   c. Click Continue at the Introduction window.
   d. Read the license agreement, click Continue, and click Agree.
   e. Click Install. When the driver is finished installing, your browser opens to an online registration form.
   f. Fill out the online registration and close the browser.
   g. Click Quit on the Finish Up window.
3. When installation is complete, in the dock, click Finder > Printer Setup Utility.
4. Click the Add button.
5. Confirm that the first drop-down menu is set to Bonjour (Rendezvous).
6. Select the printer in the window.
7. Select Xerox from the list of manufacturers in the Printer Model drop-down menu.
8. Select the appropriate printer model from the list of available devices.
9. Click the Add button.

See also:
Online Support Assistant at www.xerox.com/office/6280support

USB Connection

To install the printer driver from the Software and Documentation CD-ROM:
1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click the Phaser 6280 icon on your desktop, and then:
   a. Click Phaser 6280 Installer.
   b. Type your password, and click OK.
   c. Click Continue at the Introduction window.
   d. Read the license agreement, click Continue, and click Agree.
   e. Click Install. When the driver is finished installing, your browser opens to an online registration form.
   f. Fill out the online registration and close the browser.
   g. Click Quit on the Finish Up window.
3. When installation is complete, in the dock, click Finder > Printer Setup Utility.
4. Click the Add button.
5. Select USB from the top drop-down menu.
6. Select the printer in the top window.
7. Select Xerox from the manufacturers in the Printer Model drop-down menu.
8. Select the appropriate printer configuration from the list of available printers.
9. Click the Add button.

**LPR Connection**

To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the CD-ROM drive and select the VISE installer to install the printer software.
2. Once installation is complete, open the Printer Setup Utility for Mac OS X, version 10.3.x.

   **Note:** To locate utilities on the Macintosh hard drive, open the Applications folder, and then open the Utilities folder.

3. Click the Add button.
4. Select IP Printing from the first pull-down menu.
5. Select LPD/LPR from the second pull-down menu.
6. Enter the printer’s IP address in the Printer Address field.
7. Verify that the Queue Name field is blank.
8. Select Xerox from the Printer Model pull-down menu, and then select the corresponding PPD file.
9. Click the Add button. The printer is added to the list.
Installing the Printer Drivers

Phaser® 6280 Printer

Macintosh OS X, Version 10.4

Bonjour or USB Connection

To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click the Phaser 6280 icon on your desktop, and then:
   a. Click Phaser 6280 Installer.
   b. Type your password, and click OK.
   c. Click Continue at the Introduction window.
   d. Read the license agreement, click Continue, and click Agree.
   e. Click Install. When the driver is finished installing, your browser opens to an online registration form.
   f. Fill out the online registration and close the browser.
   g. Click Quit on the Finish Up window.
3. In the dock, click Finder > Printer Setup Utility.
4. Click the Add button.
5. Select the Default Browser in the Printer Browser window.
6. Select the Xerox Phaser 6280 Bonjour printer in the list of available printers.
   If Printer Browser does not show the appropriate printer, select Xerox from the lower drop-down menu.
7. Click the Add button.
8. Select the optional configurations: memory, paper tray, storage devise, or duplex unit, and click Continue.

LPD Connection

To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the CD-ROM drive and select the VISE installer to install the printer software.
2. Once installation is complete, open the Printer Setup Utility.

   Note: To locate utilities on the Macintosh hard drive, open the Applications folder, and then open the Utilities folder.
3. Click the Add button.
4. Select IP Printer from the upper left corner of the Printer Browser.
5. Select LPD from the pull-down menu.
6. Enter the printer’s IP address in the Address field.
7. Make sure Queue Name is blank.
8. Click Printer Model > Xerox, and select the corresponding printer model PPD file.
9. Click the Add button. The printer is added to the list.
Installing the Printer Drivers

Macintosh OS X, Version 10.5

Bonjour or USB Connection
To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click the Phaser 6280 icon on your desktop, and then:
   a. Click Phaser 6280 Installer.
   b. Type your password, and click OK.
   c. Click Continue at the Introduction window.
   d. Read the license agreement, click Continue, and click Agree.
   e. Click Install. When the driver is finished installing, your browser opens to an online registration form.
   f. Fill out the online registration and close the browser.
   g. Click Quit on the Finish Up window.
3. Click the Apple menu > System Preferences > Print & Fax.
4. Click +, and click the IP address.
5. Click the menu and select Line Printer Daemon - LPD.
6. Type the printer’s IP address in Address.
7. Click Print Using > Phaser 6280.
8. Click Add.
9. Select the optional features, and click Continue.

LPD Connection
To install the printer driver from the Software and Documentation CD-ROM:

1. Insert the CD-ROM into the CD-ROM drive and select the VISE installer to install the printer software.
2. Click the Apple menu > System Preferences > Print and Fax.
3. Click +, and click Add Printer.
4. Click IP icon at the top of the window.
5. Type the printer’s IP address in the Address field.
6. Make sure Queue is blank.
7. Click Print Using > Xerox, and select the corresponding printer model PPD file.
8. Click the Add button. The printer is added to the list.
9. Close the Print and Fax window.
This chapter includes:

- Supported Paper and Media on page 46
- About Paper on page 48
- Setting Paper Types and Sizes on page 50
- Loading Paper on page 52
- Selecting Printing Options on page 59
- Printing on Both Sides of the Paper on page 65
- Printing on Specialty Media on page 67
- Printing Custom Size or Long Paper on page 82
- Printing Confidential Documents - Secure Print on page 85
- Print After Checking Printing Result - Proof Print on page 87
Supported Paper and Media

This section includes:

- Paper Usage Guidelines on page 46
- Paper That Can Damage Your Printer on page 47
- Paper Storage Guidelines on page 47

Your printer is designed to be used with a variety of paper types. Follow the guidelines in this section to ensure the best print quality and to avoid jams.

For best results, use Xerox printing media specified for your Phaser 6280 printer. They are guaranteed to produce excellent results with your printer.

To order paper, transparencies, or other specialty media, contact your local reseller or go to www.xerox.com/office/6280supplies.

Caution: Damage caused by using unsupported paper, transparencies, and other specialty media is not covered by the Xerox warranty, service agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside these areas; please contact your local representative for details.

See also:
- Recommended Media List (United States)
- Recommended Media List (Europe)

Paper Usage Guidelines

The printer trays accommodate most sizes and types of paper, transparencies, or other specialty media. Follow these guidelines when loading paper and media in the trays:

- Envelopes and transparencies can be printed from Tray 1 (MPT) only.
- Fan paper, transparencies, or other specialty media before loading in the paper tray.
- Do not print on label stock once a label has been removed from a sheet.
- Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with release strips.
- All envelopes should be printed single-sided only.
- Some wrinkling and embossing may occur when printing envelopes.
- Do not overload the paper trays. Do not load paper above the fill line on the inside of the paper guide.
- Adjust the paper guides to fit the paper size. For Trays 2–3, the paper guides click into place when they are adjusted correctly.
- If excessive jams occur, use paper or other media from a new package.

See also:
- Printing Transparencies on page 67
- Printing Envelopes on page 69
- Printing Labels on page 72
Paper That Can Damage Your Printer

Your printer is designed to use a variety of media types for print jobs. However, some media can cause poor output quality, increased paper jams, or damage to your printer.

Unacceptable media includes:

- Rough or porous media
- Plastic media other than supported transparencies
- Paper that has been folded or wrinkled
- Paper with staples
- Envelopes with windows or metal clasps
- Padded envelopes
- Non-laser glossy or coated paper
- Perforated media

Paper Storage Guidelines

Providing good storage conditions for your paper and other media contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper items are susceptible to damage from ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and fluorescent bulbs, is particularly damaging to paper items. The intensity and length of exposure to visible light on paper items should be reduced as much as possible.
- Maintain constant temperatures and relative humidity.
- Avoid attics, kitchens, garages, and basements for storing paper. Inside walls are drier than outside walls where moisture can collect.
- Store paper flat. Paper should be stored on pallets, cartons, shelves, or in cabinets.
- Avoid having food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load them into the printer. Leave paper in the original packaging. For most commercial cut-size grades, the ream wrapper contains an inner lining that protects the paper from moisture loss or gain.
- Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag and reseal it for protection. Some specialty media is packaged inside resealable plastic bags.
About Paper

Using unsuitable paper may lead to paper jams, poor print quality, breakdown and damage to your printer. In order to use the features of this printer effectively, use the suggested paper that is recommended here.

Usable Paper

The types of paper that can be used on this printer are as follows:

<table>
<thead>
<tr>
<th>Paper Tray</th>
<th>Size</th>
<th>Paper Type (Weight)</th>
<th>Loading Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1 (MPT)</td>
<td>Letter (8.5 x 11 in.), Legal (8.5 x 14 in.), Executive (7.25 x 10.5 in.), Folio (8.5 x 13 in.), #10 Commercial (4.1 x 9.5 in.), Monarch (3.8 x 7.5 in.) A4 (210 x 297 mm) A5 (148 x 210 mm) B5 (182 x 257 mm) DL (110 x 220 mm) C5 (162 x 229 mm) Custom: 76.2–127 mm (3–5 in.) 216–355.6 mm (8.5–14 in.)</td>
<td>Plain (65–120 g/m²) (17–32 lb. Bond) Thin Card Stock (100–163 g/m²) (37–60 lb. Cover) Thick Card Stock (160–220 g/m²) (60–80 lb. Cover) Glossy Paper (100–160 g/m²) (37–60 lb. Cover) Thick Glossy Paper (160 220 g/m², 60–80 lb. Cover) Labels</td>
<td>150 sheets (Standard paper) or 15 mm or below</td>
</tr>
<tr>
<td>Tray 2</td>
<td>Letter (8.5 x 11 in.), Legal (8.5 x 14 in.), Executive (7.25 x 10.5 in.), Folio (8.5 x 13 in.) A4 (210 x 297 mm) A5 (148 x 210 mm) B5 (182 x 257 mm)</td>
<td>Plain (65–120 g/m²) (17–32 lb. Bond) Thin Card Stock (100–163 g/m²) (37–60 lb. Cover) Thick Card Stock (160–220 g/m²) (60–80 lb. Cover) Glossy Paper (100–160 g/m²) (37–60 lb. Cover) Thick Glossy Paper (160 200 g/m², 60–80 lb. Cover) Labels</td>
<td>Tray 2 holds 250 sheets. Tray 3 holds 550 sheets. (Standard paper) or 27.6 mm or below</td>
</tr>
<tr>
<td>Tray 3</td>
<td>A4 (210 x 297 mm) A5 (148 x 210 mm) B5 (182 x 257 mm) Custom: 148–215.9 mm (5.83–8.5 in.) 210–355.6 mm (8.27–14 in.)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For details on how to load envelopes, see Printing Envelopes on page 69.

Printing on paper that has different settings from the paper size or paper type selected on the print driver, or loading paper into an unsuitable paper tray for printing, may lead to paper jams. To ensure that printing is correctly done, select the correct paper size, paper type, and paper tray.

The printed image may fade due to moisture, such as water, rain or vapor. For details, contact your reseller.
2-Sided Printing Paper Types and Sizes

The available paper types and sizes for 2-sided printing are as follows:

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Paper Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210 x 297 mm)</td>
<td>Plain, Thin Card Stock, Glossy</td>
</tr>
<tr>
<td>B5 JIS (182 x 257 mm)</td>
<td>(65–163 g/m², 17–43 lb. Bond)</td>
</tr>
<tr>
<td>A5 A5 (148 x 210 mm)</td>
<td>Custom Sizes</td>
</tr>
<tr>
<td>Letter (8.5 x 11 in.)</td>
<td>Width: 148–215.9 mm (5.83–8.5 in.)</td>
</tr>
<tr>
<td>Folio (8.5 x 13 in.)</td>
<td>Height: 210–355.6 mm (8.27–14 in.)</td>
</tr>
<tr>
<td>Legal (8.5 x 14 in.)</td>
<td></td>
</tr>
<tr>
<td>Executive (7.25 x 10.5 in.)</td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td></td>
</tr>
</tbody>
</table>
Setting Paper Types and Sizes

Setting Paper Trays

When loading paper in Tray 3 or the 550-Sheet Feeder (optional), it is necessary to set the paper type on the control panel.

When loading paper in Tray 1 (MPT), set the paper size and type on the control panel when printing. When MPT Mode has been set to Panel Specified (default) on the control panel, you can set the paper size and type on the control panel.

This section describes how to set the paper size and type on the control panel.

Note: When you set MPT Mode to Panel Specified, printing will be performed only when the settings for the paper size and type configured on the print driver match the settings on the control panel. When the settings on the print driver and control panel do not match, follow the instructions displayed on the control panel.

You can also display the message to set the paper size and type on the control panel every time you load paper into each tray.

See also:
Description of Menu Items on page 93

Setting Paper Types

Caution: Paper type settings must match those of the actual paper loaded in the trays. Otherwise, print-quality problems can occur.

1. Press the Menu button to display the Menu screen.
2. Select Tray Settings, and then press the OK button.
3. Select the tray, and then press the OK button.
4. Select Paper Type, and then press the OK button.
5. Select the correct paper type for the loaded paper, and then press the OK button.
6. Press the Menu button.
Setting Paper Sizes

1. Press the Menu button to display the Menu screen.
2. Select Tray Settings, and then press the OK button.
3. Select the tray, and then press the OK button.
4. Select Paper Size for Custom Size only, and then press the OK button.

   **Note:** Select Driver Size when you set a custom size paper from Tray 1 (MPT).

5. Select the paper size, and then press the OK button.
6. Press the Menu button.
Loading Paper

This section includes:

- Loading Paper in Tray 1 (MPT) on page 52
- Loading Paper in Trays 2-3 on page 55

Loading Paper in Tray 1 (MPT)

Use Tray 1 (MPT) for a wide range of media including:

- Plain paper
- Card stock
- Labels
- Envelopes
- Transparencies
- Glossy paper
- Specialty media including business cards, postcards, trifold brochures, and weatherproof paper
- Pre-printed paper (paper already printed on one side)
- Custom size paper

See also:
- About Paper on page 48
- Using Tray 1 video tutorial at www.xerox.com/office/6280support

Loading Paper in Tray 1 (MPT)

In addition to plain paper, Tray 1 (MPT) can use various other sizes and types of print media, such as envelopes and transparencies.

Make sure of the following points when loading paper in Tray 1 (MPT).

You can load up to 150 sheets or a stack of paper (65 – 220 g/m², 17 – 40 lb. Bond, 40 – 80 lb. Cover) less than 15 mm high. Sizes can start from 3 x 5”.

- Tray 1 (MPT) accepts print media within the following dimensions:
  - Width: 76.2 – 216.0 mm (3 – 8.5 in.)
  - Length: 127.0 – 355.6 mm (5 – 14 in.)
- You can load media that is 65 – 163 g/m² (17 – 43 lb. Bond) for duplex printing.
Make sure of the following points to avoid any troubles during printing.

- Do not load different types of paper at the same time.
- Use high quality paper for laser printers to print at high quality. See About Paper on page 48.
- Do not remove or add paper to Tray 1 (MPT) when printing, or if there is any paper still in the tray. Doing so may cause a paper jam.
- Do not put any objects other than paper on Tray 1 (MPT). Also, do not push or force down Tray 1 (MPT).
- Always load paper short-edge feed.

To load paper in Tray 1 (MPT):

1. Gently pull open the Tray 1 (MPT) cover.

2. Slide the width guides to the edge of the tray. The width guides should be fully extended.
3. Insert all media facedown and top edge first into Tray 1 (MPT).

![Image of printer with tray open]

**Note:** Do not force the paper.

4. Slide the width guides until they rest lightly against the edge of the paper stack.

![Image of printer with width guides adjusted]

**Note:** Be careful not to bend the paper.

If Tray 1 (MPT) is configured for **Driver Size**, configure the paper size and type in the print driver.

When **MPT Mode** is set to **Panel Specified**, you need to set the paper type and size settings for the tray on the control panel in advance.

**See also:**
- Setting Paper Types and Sizes on page 50
Loading Paper in Trays 2-3

Use Trays 2-3 for a wide range of media including:

- Plain paper
- Thin card stock
- Glossy paper
- Labels

See also:
Printing on Specialty Media on page 67

Loading Paper in Trays 2-3

This section describes how to load paper in the standard and optional paper trays. All trays are loaded the same way.

Caution: Do not remove the tray during printing. It may cause a paper jam.

1. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.
2. Slide the width guides to the edge of the tray. The width guides should be fully extended.

Note: When loading paper that is 216 mm (8.5 in.) wide, such as Letter or Legal size paper, set the tab on the side of the tray to the [8.5] position.

3. Squeeze the green tab on the length guide, and then slide the tray until the arrow lines up with the appropriate paper size. The guide clicks into place.
4. Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.

5. Place the print media into the tray with the print side face-up.

   **Note:** Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6. Slide the width guides and length guide until they rest lightly against the edge of the print media stack.
7. Insert the tray into the printer, and push until it stops.

**Caution:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
Selecting Printing Options

This section includes:

- Selecting Printing Preferences (Windows) on page 59
- Selecting Options for an Individual Job (Windows) on page 60
- Selecting Options for an Individual Job (Macintosh) on page 62

Selecting Printing Preferences (Windows)

Printer preferences control all of your print jobs, unless you override them specifically for a job. For example, if you want to use automatic 2-sided printing for most jobs, set this option in printer settings.

To select printer preferences:

1. Select one of the following options:
   - Windows 2000 and Windows Server 2003: Click Start, select Settings, and then click Printers.
   - Windows XP: Click Start, Settings, and then select Printers and Faxes.
   - Windows Vista: Click Start, and then click Printers.

2. In the Printers folder, right-click the icon for your printer.
3. From the pop-up menu, select Printing Preferences or Properties.
4. To set standard printing options:
   a. Select the Advanced tab, and then click the Printing Defaults button.
   b. Make selections on the driver tabs, and then click the OK button to save your selections. You return to the Properties window.
5. To activate optional features for a postscript driver:
   a. Click the Device Settings tab in the Properties window.
   b. Activate the options by selecting from the menus next to either Memory, Paper Tray Configuration, Storage Device, and/or Duplex Unit.
   c. Click OK.
6. To activate optional features for a PCL driver:
   a. Click the Options tab in the Properties window.
   b. In the Items field, select either Memory Capacity, Hard Disk, Duplex Unit, 550 Sheet Feeder, or RAM Disk.
   c. Click the Settings for menu, and select Available or, for Memory Capacity, select the new setting.
   d. Click OK.

Note: For more information about Windows printer driver options, click the Help button on the printer driver tab to view the online help.
Selecting Options for an Individual Job (Windows)

If you want to use special printing options for a particular job, change the driver settings before sending the job to the printer. For example, if you want to use Photo print-quality mode for a particular graphic, select this setting in the driver before printing that job.

1. With the desired document or graphic open in your application, access the Print dialog box.
2. Select the Phaser 6280 printer, select the Properties button to open the printer driver.
3. Make selections from the driver tabs. See the following table for specific printing options.

   **Note:** In Windows 2000, Windows XP, and Windows Server 2003, you can save current printing options with a distinctive name and apply them to other print jobs. Select either the Advanced, Paper/Output, Image Options, or Layout tab, and then select a Saved Setting. Click the Help button for more information.

4. Click the OK button to save your selections.
5. Print the job.
Selecting Printing Options

See the following table for specific PCL printing options:

### PCL Printing Options for Windows Operating Systems

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Driver Tab</th>
<th>Printing Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista, Windows 2000, Windows XP, or Windows Server 2003</td>
<td>Paper/Output tab</td>
<td>• Job Type&lt;br&gt;• Document size, paper type, and tray selection&lt;br&gt;• 2-sided printing&lt;br&gt;• Feed orientation&lt;br&gt;• Saved Settings&lt;br&gt;• Covers/Separators&lt;br&gt;• Transparency Separators&lt;br&gt;• Printer Status</td>
</tr>
<tr>
<td></td>
<td>Image Options tab</td>
<td>• Output Color&lt;br&gt;• Print Quality&lt;br&gt;• Image adjustment, image type, image correction&lt;br&gt;• Image Settings&lt;br&gt;• Color Balance&lt;br&gt;• Profile Settings</td>
</tr>
<tr>
<td></td>
<td>Layout tab</td>
<td>• Pages per sheet (N-up)&lt;br&gt;• Image Orientation&lt;br&gt;• Booklet/Poster/Mixed Document/Rotation layout&lt;br&gt;• Output Size&lt;br&gt;• Margin Shift</td>
</tr>
<tr>
<td></td>
<td>Watermarks/Overlays tab</td>
<td>• Watermarks&lt;br&gt;• Overlays</td>
</tr>
<tr>
<td></td>
<td>Advanced tab</td>
<td>• Skip Blank Pages&lt;br&gt;• Draft Mode&lt;br&gt;• Banner Sheet&lt;br&gt;• Size Mismatch&lt;br&gt;• Graphics Settings&lt;br&gt;• Font Settings</td>
</tr>
</tbody>
</table>

**Note:** If your driver does not display the options listed in the table above, see [Enabling Options](#) on page 134 for more information.
Selecting Printing Options

See the following table for specific PostScript printing options:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Driver Tab</th>
<th>Printing Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista, Windows 2000, Windows XP, or Windows Server 2003</td>
<td>Paper/Output tab</td>
<td>• Job Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Document size, paper type, and tray selection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2-sided printing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orientation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Output Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Printer Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Saved Settings</td>
</tr>
<tr>
<td></td>
<td>Image Options tab</td>
<td>• Image Settings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Color corrections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Brightness</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Color Balance</td>
</tr>
<tr>
<td></td>
<td>Layout tab</td>
<td>• Pages per sheet (N-up)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fit to new paper size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Booklet layout</td>
</tr>
<tr>
<td></td>
<td>Advanced tab</td>
<td>• Transparency Separators</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Image options: reduce/enlarge, image smoothing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Details: blank pages, tray mapping</td>
</tr>
</tbody>
</table>

**Note:** If your driver does not display the options listed in the table above, see Enabling Options on page 134 for more information.

**Selecting Options for an Individual Job (Macintosh)**

To select print settings for a particular job, change the driver settings before sending the job to the printer.

1. With the document open in your application, click **File**, and then click **Print**.
2. Select the desired printing options from the menus and drop-down lists that are displayed.

**Note:** In Macintosh OS X, click **Save Preset** on the **Print** menu screen to save the current printer settings. You can create multiple presets and save each with its own distinctive name and printer settings. To print jobs using specific printer settings, click the applicable saved preset in the **Presets** list.

3. Click **Print** to print the job.

See the following table for specific printing options:
### Macintosh PostScript Driver Settings

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Driver Drop-Down Title</th>
<th>Printing Options</th>
</tr>
</thead>
</table>
| Mac OS X, Version 10.4 and 10.5 | Copies & Pages | • Copies  
• Pages |
|                  | **Layout**            | • Pages per sheet  
• Layout direction  
• Border  
• 2-sided printing |
|                  | **Scheduler**         | • Print document (now, at a specified time, on hold)  
• Priority (urgent, high, medium, low) |
|                  | **Paper Handling**    | • Page order  
• Print (all, odd, even)  
• Destination paper size |
|                  | **ColorSync**         | • Color conversion  
• Quartz filter |
|                  | **Cover Page**        | • Print cover page (none, before document, after document)  
• Cover page type  
• Billing information |
|                  | **Error Handling**    | • PostScript errors  
• Tray Switching |
|                  | **Paper Feed**        | • Paper source |
|                  | **Job Type**          | • Secure prints  
• Proof prints |
|                  | **Job Control**       | • User account  
• Administrator account |
|                  | **Printer Features**  | • Print quality/color  
• Color adjustment  
• Color balance (C, M, Y, K)  
• Media handling  
• Printer specific options |
|                  | **Summary**           | • Summarizes the driver selections |
|                  | **Color Matching (10.5 only)** | • Color sync or in printer  
• Profile selection |
|                  | **Supply Levels**     | • Cyan toner cartridge  
• Magenta toner cartridge  
• Yellow toner cartridge  
• Black toner cartridge |
### Macintosh PostScript Driver Settings (Continued)

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Driver Drop-Down Title</th>
<th>Printing Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X, Version 10.3</td>
<td>Copies &amp; Pages</td>
<td>• Copies&lt;br&gt;• Pages</td>
</tr>
<tr>
<td></td>
<td><strong>Layout</strong></td>
<td>• Pages per sheet&lt;br&gt;• Layout direction&lt;br&gt;• Border&lt;br&gt;• Two-sided printing</td>
</tr>
<tr>
<td></td>
<td><strong>Output Options</strong></td>
<td>• PDF&lt;br&gt;• Postscript</td>
</tr>
<tr>
<td></td>
<td><strong>Scheduler</strong></td>
<td>• Print document (now, at a specified time, on hold)&lt;br&gt;• Priority (urgent, high, medium, low)</td>
</tr>
<tr>
<td></td>
<td><strong>Paper Handling</strong></td>
<td>• Reverse page order&lt;br&gt;• Print (all, odd, even)</td>
</tr>
<tr>
<td></td>
<td><strong>ColorSync</strong></td>
<td>• Color matching&lt;br&gt;• Quartz filter</td>
</tr>
<tr>
<td></td>
<td><strong>Cover Page</strong></td>
<td>• Print cover page (none, before document, after document)&lt;br&gt;• Cover page type&lt;br&gt;• Billing information</td>
</tr>
<tr>
<td></td>
<td><strong>Error Handling</strong></td>
<td>• PostScript errors&lt;br&gt;• Tray Switching</td>
</tr>
<tr>
<td></td>
<td><strong>Paper Feed</strong></td>
<td>• Paper source</td>
</tr>
<tr>
<td></td>
<td><strong>Job Type</strong></td>
<td>• Secure prints, personal prints, proof prints, and saved prints</td>
</tr>
<tr>
<td></td>
<td><strong>Job Control</strong></td>
<td>• User account&lt;br&gt;• Administrator account</td>
</tr>
<tr>
<td></td>
<td><strong>Image Quality</strong></td>
<td>• Print quality&lt;br&gt;• RGB color corrections neutral grays&lt;br&gt;• Image smoothing</td>
</tr>
<tr>
<td></td>
<td><strong>Printer Features</strong></td>
<td>• Print quality/color&lt;br&gt;• Color adjustment&lt;br&gt;• Color balance (C, M, Y, K)&lt;br&gt;• Media handling&lt;br&gt;• Printer specific options</td>
</tr>
<tr>
<td></td>
<td><strong>Summary</strong></td>
<td>• Summarizes the driver selections</td>
</tr>
</tbody>
</table>
Printing on Both Sides of the Paper

This section includes:

- Automatic 2-Sided Printing Guidelines on page 65
- Binding Edge Options on page 66
- Selecting 2-Sided Printing on page 66

Note: For information about manual two-sided printing, go to the Online Support Assistant at www.xerox.com/office/6280support.

Automatic 2-Sided Printing Guidelines

Automatic 2-sided printing is available from the Phaser 6280DN configuration. Before printing a 2-sided document, verify that the paper is a supported size for the tray. For a list of supported paper sizes, see Supported Paper and Media on page 46. The following paper and media cannot be used for 2-sided printing:

- Transparencies
- Envelopes
- Labels
- Any die-cut specialty media, such as business cards
- Thick card stock

See also:

- 2-Sided Printing Paper Types and Sizes on page 49
- Supported Paper and Media on page 46
Binding Edge Options

When you use the printer driver to select 2-sided printing, also select the binding edge, which determines how the pages turn. The actual outcome depends on the orientation (portrait or landscape) of images on the page, as displayed in the following illustrations.

<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Flip on Long Edge" /></td>
<td><img src="image2" alt="Flip on Short Edge" /></td>
</tr>
<tr>
<td><img src="image3" alt="Flip on Short Edge" /></td>
<td><img src="image4" alt="Flip on Long Edge" /></td>
</tr>
</tbody>
</table>

Selecting 2-Sided Printing

To select automatic 2-sided printing:

1. Insert paper in the tray. For more information, see Loading Paper on page 52.
2. In the printer driver, select 2-sided printing as shown in the following table, and then press the OK button.

To select automatic 2-sided printing:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X, version 10.3 and higher</td>
<td>1. In the Print dialog box, select Layout from the menu under the Presets menu. 2. Select Long-edged printing or Short-edged printing.</td>
</tr>
</tbody>
</table>

Note: If your driver does not display the options listed in the table above, see Enabling Options on page 134 for more information.

See also:
- Loading Paper in Tray 1 (MPT) on page 52
- Loading Paper in Trays 2-3 on page 55
Printing on Specialty Media

This section includes:

- Printing Transparencies on page 67
- Printing Envelopes on page 69
- Printing Labels on page 72
- Printing Glossy Paper on page 77
- Printing Custom Size or Long Paper on page 82

Printing Transparencies

Transparencies can be printed from all trays. They should be printed on one side only. For best results, use only recommended Xerox transparencies.

To order paper, transparencies, or other specialty media, contact your local reseller or go to www.xerox.com/office/6280supplies.

Caution: Damage caused by using unsupported paper, transparencies, and other specialty media is not covered by the Xerox warranty, service agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside these areas; please contact your local representative for details.

See also:
- Recommended Media List (United States)
- Recommended Media List (Europe)

Guidelines

- Remove all paper before loading transparencies in the tray.
- Do not load more than 25 sheets in Tray 1 (MPT). Overloading the tray may cause the printer to jam.
- Handle transparencies by the edges using both hands to avoid fingerprints and creases, which may cause poor print quality.
- Fan transparencies before loading in the paper tray.

This section explains how to print on transparencies.
Loading Transparencies

**Note:** Transparencies with a white frame and full-color transparencies cannot be used.

1. After carefully fanning a small stack of transparencies, load them into Tray 1 (MPT) with the side to be printed facing down. Load no more than 25 transparencies at a time.

2. Slide the paper guides to the size of the transparencies.
3. Pull out the output tray extension when loading paper, such as transparencies.

Printing on Transparencies

When **MPT Mode** is set to **Panel Specified**, you need to set the paper type and size settings for the tray on the control panel in advance. See **Setting Paper Types and Sizes** on page 50.

Printing transparencies continuously may lead to the output transparencies sticking to each other. Remove the transparencies from the output tray after about 20 sheets, and then fan them to lower their temperatures.

Using the PostScript Driver

To print on transparencies using the PostScript print driver, display the **Paper/Output** tab.

1. From the **File** menu, select **Print**.
2. Select this printer as the printer to be used and click **Preferences** or **Properties**.
3. Select the **Paper/Output** tab.
4. From **Paper Type**, select **Transparency**.
5. From **Paper Tray**, select **Tray 1 (MPT)**.
6. From **Paper Size**, select the size of the original document.
7. Click **OK**.
8. Click **Print** in the **Print** dialog box to start printing.

**Using the PCL Driver**

To print on transparencies using the PCL print driver, display the **Paper/Output** tab.

1. From the **File** menu, select **Print**.
2. Select this printer as the printer to be used and click **Preferences** or **Properties**.
3. Select the **Paper/Output** tab.
4. From **Paper Tray**, select **Tray 1 (MPT)**.
5. Select **Transparency** from **Paper Type**.
6. From **Paper Size**, select the size of the original document.
7. Click **OK**.
8. Click **Print** in the **Print** dialog box to start printing.

**Printing Envelopes**

Envelopes can be printed only from Tray 1 (MPT).

**Guidelines**

- Successful envelope printing is highly dependent on the quality and construction of the envelopes. Use envelopes made specifically for laser printers.
- It is recommended that you maintain constant temperatures and relative humidity.
- Store unused envelopes in their packaging to avoid the effects of moisture and dryness which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.
- Avoid padded envelopes; purchase envelopes that lie flat on a surface.
- Remove air bubbles from the envelopes before loading by setting a heavy book on top of the envelopes.
- If wrinkling or embossing problems occur, use a different brand of envelopes made specifically for laser printers.

**Caution**: Never use envelopes with windows or metal clasps; they can damage the printer. Damage caused by using unsupported envelopes is not covered under the Xerox warranty, service agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside these areas, please contact your local representative for details.
Loading Envelopes

To load envelopes, insert the envelopes with the flaps closed and at the right side. The print side must be facing down. You can load envelopes up to the maximum fill line in the tray at one time.

The following explains how to load envelopes in Tray 1 (MPT).

Note: The reverse side of the envelope cannot be printed on. Envelopes can get wrinkled or the print quality is reduced depending on the type used.

See also:
   About Paper on page 48

To load envelopes in Tray 1 (MPT):

1. Insert the envelopes with the side to be printed facedown.

2. Slide the paper guides to the size of the envelope.
Printing on Envelopes

When MPT Mode is set to Panel Specified, you need to set the paper type and size settings for the tray on the control panel in advance. See Setting Paper Types and Sizes on page 50.

Using the PostScript Driver

To print on envelopes using the PostScript print driver, display the Paper/Output tab.

1. From the File menu, select Print.
2. Select this printer as the printer to be used and click Preferences or Properties.
4. From Paper Type, select Envelope.
5. From Paper Tray, select Tray 1 (MPT).
6. From Paper Size, select the size of the original document.
7. Click OK.
8. Click Print in the Print dialog box to start printing.

Using the PCL Driver

To print on envelopes using the PCL print driver, display the Paper/Output tab.

1. From the File menu, select Print.
2. Select this printer as the printer to be used and click Preferences or Properties.
4. From Paper Tray, select Tray 1 (MPT).
5. From Paper Type, select Envelope.
6. From Paper Size, select the size of the original document.
7. Select the Layout tab.
8. From Fit to New Paper Size, select the size of the envelope, and then click OK.
9. If necessary, click Booklet/Poster/Mixed Document/Rotation, and select Image Rotation 180deg.
10. Click OK.
11. Click Print in the Print dialog box to start printing.
Printing Labels

Labels can be printed from all trays.

To order paper, transparencies, or other specialty media, contact your local reseller or go to www.xerox.com/office/6280supplies.

See also:
About Paper on page 48

Guidelines

- Do not use vinyl labels.
- Print only on one side of the sheet of labels.
- Do not use any sheet where labels are missing; it may damage the printer.
- Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal it.
- Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in extreme conditions may cause print-quality problems or cause them to jam in the printer.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam the printer.

Printing Labels from Tray 1 (MPT)

1. Gently pull open the Tray 1 (MPT) cover and open the paper guides.
2. Fan the labels to release sheets that are stuck together.

3. Insert the labels into Tray 1 (MPT), and adjust the paper guides to fit the sheets.
   - Place the side to be printed **facedown** with the top of the sheets entering first.
   - Do not load more than 25 sheets.

4. In the printer driver, select either **Labels** as the paper type or **Tray 1 (MPT)** as the paper tray, and click **OK**.

5. If the printer is set to **Panel Specified**, the control panel asks for media type and size.
Printing Labels from Trays 2-3

1. Pull the tray out of the printer.

2. If necessary, open the paper guides:
   - Squeeze the green tab on the length guide, and then slide the tray until the arrow lines up with the appropriate paper size. The guide clicks into place.
   - Slide the green side guides outward.
3. Fan the label sheets to release sheets that are stuck together.

4. Insert the label sheets into the tray. Place the side to be printed face up with the top of the page toward the front of the printer.

   **Note:** Do not load the paper above the fill line indicated on the tray. Overloading the tray may cause jams. The following illustration indicates the maximum fill line for transparencies, labels, and glossy paper.
5. If necessary, press the paper guides inward to fit the sheets.

   **Note:** When the paper guides are adjusted correctly, there may be a small space between the labels and the guides.

6. Insert the tray into the tray slot, and push the tray completely into the printer.

7. On the control panel, select the paper type:
   a. Select **Menu**.
   b. Select **Tray Settings**, and then press the **OK** button.
   c. Select **Tray 2** or **Tray 3** and then press the **OK** button.
   d. Select **Paper Type**, and then press the **OK** button.
   e. Select **Labels**, and then press the **OK** button.

8. In the printer driver, select either **Labels** as the paper type or the appropriate tray as the paper tray.
Printing on Specialty Media

Printing Glossy Paper

Glossy paper can be printed from any tray. It can be printed on both sides.

To order paper, transparencies, or other specialty media, contact your local reseller or go to www.xerox.com/office/6280supplies.

Guidelines

• Do not open sealed packages of glossy paper until you are ready to load them into the printer.
• Leave glossy paper in the original wrapper, and leave the packages in the shipping carton until ready to use.
• Remove all other paper from the tray before loading glossy paper.
• Load only the amount of glossy paper you are planning to use. Do not leave glossy paper in the tray when you are finished printing. Reinsert unused glossy paper in the original wrapper and seal.
• Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy paper to curl and jam the printer.

Printing Glossy Paper from Tray 1 (MPT)

1. Gently pull open the Tray 1 (MPT) cover and open the paper guides.
2. Fan the glossy paper to release sheets that are stuck together.

3. Insert the glossy paper into Tray 1 (MPT), and adjust the paper guides to fit the paper.
   - Place the side to be printed facedown.
   - Do not load more than 25 sheets.

4. In the printer driver, select either Glossy Paper as the paper type or Tray 1 (MPT) as the paper tray, and click OK.

5. If the printer is set to Panel Specified, the control panel asks for media type and size.
Printing Glossy Paper from Trays 2-3

1. Pull the tray out of the printer.

2. If necessary, open the paper guides:
   - Squeeze the green tab on the length guide, and then slide the tray until the arrow lines up with the appropriate paper size. The guide clicks into place.
   - Slide the green side guides outward.
3. Fan the paper to release sheets that are stuck together.

4. Insert the paper into the tray.

**Note:** Do not load the paper above the fill line indicated on the tray. Overloading the tray may cause jams. The following illustration indicates the maximum fill line for transparencies, labels, and glossy paper.
5. If necessary, press the paper guides inward to fit the paper.

   **Note:** When the paper guides are adjusted correctly, there may be a small space between the paper and the guides.

6. Insert the tray into the tray slot, and push the tray completely into the printer.

7. On the control panel, select the glossy paper type:
   a. Select **Menu**.
   b. Select **Tray Settings**, and then press the **OK** button.
   c. Select **Tray 2** or **Tray 3** and then press the **OK** button.
   d. Select **Paper Type**, and then press the **OK** button.
   e. Select **Glossy Paper**, and then press the **OK** button.

8. In the printer driver, select either **Glossy Paper** as the paper type or the appropriate tray as the paper tray.
Printing Custom Size or Long Paper

This section explains how to print on custom size paper, such as long paper using the PCL print driver.

Custom size paper can be loaded in each tray. The way to load custom size paper in the paper tray is the same as the one to load standard size paper. The way to load custom size paper in Tray 1 (MPT) is the same as the one to load standard size paper.

When MPT Mode is set to Panel Specified, you need to set the paper type and size settings for the tray on the control panel in advance.

See also:
- Loading Paper in Trays 2-3 on page 55
- Loading Paper in Tray 1 (MPT) on page 52
- Setting Paper Types and Sizes on page 50

Defining Custom Paper Sizes

Before printing, set the custom size on the print driver.

Note: When setting the paper size on the print driver and control panel, be sure to specify the same size as the actual paper used. Setting the wrong size for printing will cause printer failure. This is especially true if you configure a bigger size when using a narrow width paper.

Using the PCL Driver

On the PCL print driver, set the custom size in the Custom Paper Size dialog box. This section explains the procedure using Windows XP as an example.

For Windows 2000 or later, an administrator’s password only allows users with administrator rights to change the settings. Users without the rights of administrator can only check the contents.

When configuring the Custom Paper Size dialog box in Windows 2000 or later, settings of other printers on the computer will also be affected as the form data base of the computer is used by a local printer. For a shared printer on the network, settings of other shared printers on the same network in another computer will also be affected as the form data base on the server with existing print queue is used.

1. To start, do the following:
   - Windows 2000-XP: Click Start > Settings > Printers and Faxes.
   - Windows Vista: Click Start > Printers.
     Right-click the printer and select Properties.
2. Select the Configuration tab.
3. Click Custom Paper Size.
4. Use the Details list box to select the custom setup you want to define.
5. Specify the length of the short edge and long edge under Settings For. You can specify the values either by entering them directly or using the Up Arrow and Down Arrow buttons. The length of the short edge cannot be longer than the long edge, even if it is within the specified range. The length of the long edge cannot be shorter than the short edge, even if it is within the specified range.

6. To assign a paper name, select the Name Paper Size check box, and then enter the name in Paper Name. Up to 14 characters can be used for the paper name.

7. If necessary, repeat steps 4 to 6 to define another custom size.

8. Click OK twice.

**Using the PostScript Driver**

On the PostScript print driver, set the custom size in the Custom Paper Size dialog box. This section explains the procedure using Windows XP as an example.

1. To start, do the following:
   - **Windows 2000-XP**: Click Start > Settings > Printers and Faxes.
   - **Windows Vista**: Click Start > Printers.
   Right-click the printer and select Properties.

2. Select the General tab.

3. Click the Printing Preferences button.


5. Specify the length of the short edge and long edge under Custom Size Settings. You can specify the values either by entering them directly. The length of the short edge cannot be longer than the long edge, even if it is within the specified range. The length of the long edge cannot be shorter than the short edge, even if it is within the specified range.

6. Click OK three times.

**Printing on Custom Size Paper**

Use the following procedures to print using either the PCL or PostScript drivers.

**Using the PCL Driver**

The procedure to print on custom size paper using the PCL print driver is as follows.

1. From the File menu, select Print.

2. Select this printer as the printer to be used and click Preferences or Properties.


4. Select the appropriate paper tray from Paper Tray.

5. Select the appropriate paper type from Paper Type.

6. From Paper Size, select the size of the original document.

7. Click the Layout tab.

8. The Fit to New Paper Size menu defaults to Same As Paper Size.

9. Click OK.

10. Click Print in the Print dialog box to start printing.
Using the PostScript Driver

The procedure to print on custom size paper using the PostScript print driver is as follows.

1. From the File menu, select Print.
2. Select this printer as the printer to be used and click Preferences or Properties.
5. Specify the length of the short edge and long edge under Custom Size Settings. You can specify the values either by entering them directly. The length of the short edge cannot be longer than the long edge, even if it is within the specified range. The length of the long edge cannot be shorter than the short edge, even if it is within the specified range.
6. Click OK twice.
7. Select the appropriate paper tray from Paper Tray.
8. Select the appropriate paper type from Paper Type and click OK.
9. Click Print in the Print dialog box to start printing.
Printing Confidential Documents - Secure Print

When the hard drive or additional memory is added, you can use the secure print feature.

Note: The data stored in the RAM disk is erased when the printer is switched off.

About Secure Print

Secure Print is a feature that allows you to assign a password to a print job from the computer, send it to the printer for temporarily storing, and start printing the data from the control panel. You can also store the print data in the printer without attaching a password. By storing frequently-used data in the printer, you can print the data with just an operation from the printer, and without sending the data from the computer repeatedly.

Note: You can select whether to delete secure print data after printing.

See also:
- Printing from the Control Panel on page 88
- System Setup on page 98

Configuring Secure Print

The procedure to configure Secure Print using the PCL or PostScript print driver is as follows.

Follow the steps for the secure print settings at the computer and send data to the printer for printing. Then, follow the steps for the output procedure at the printer to output the printed pages.

Printing from the Computer

Note: Ensure the RAM disk is set to available. You can find this under the Options tab using the PCL print driver or the Device Settings tab using the PostScript print driver. The RAM disk also needs to be enabled via the control panel. For instructions about enabling options, see Enabling Options on page 134.

1. From the File menu, select Print.
2. Select the printer, and click Preferences or Properties.
3. Click the Paper/Output tab.
4. In the Job Type field, select Secure Print.
5. Click the Setup button.
6. In the Username field, enter your user name.
7. In the Password field, enter a numeric password.
8. If you want to use a specified document name to access the document from the control panel:
   a. In the Retrieve Document Name field, select Enter Document Name.
   b. In the Document Name field, enter the name that will appear on the control panel.
9. If you want the printer to automatically name the document using a time stamp, in the Retrieve Document Name field, select Use Existing Name.

10. Click OK twice to accept the Secure Print settings, and then click Print to send the job. Now follow the instructions in Printing from the Control Panel, below, to continue printing the job.

**Printing from the Control Panel**

This section explains the procedure to print data stored in the printer by Secure Print.

**Note:** You can also delete, without printing, secure print data stored in the printer. See System Setup on page 98.

1. On the control panel, press the Back Arrow button to display the Walk-Up Features menu.

2. Select Secure Print, and then press the OK button.

3. Select your user name, and then press the OK button.

4. Press the Up Arrow or Down Arrow button to scroll to the correct number for the first digit of the numeric password, and then press the Forward Arrow button to accept that digit.

   **Note:** The digit becomes an asterisk after you press the Forward Arrow button.

5. Repeat Step 4 for each digit of the password, and then press the OK button.

6. If you submitted more than one secure print job, select the name of the job that you want to print, and then press the OK button.

7. Select Del after Print or Print and Save, and then press the OK button.

8. Scroll to the desired number of copies, and then press the OK button to print the job.

The displayed user ID (up to 8 characters) is the User ID specified in the Secure Print dialog box of the Paper/Output tab of the print driver.

For the password, enter the Password set in the Secure Print dialog box of the Paper/Output tab of the print driver. If Password is not configured, there will be no setting on the control panel.

The document name displayed (up to 12 characters) is the Document Name specified in the Secure Print dialog box of the Basic tab of the print driver.

**Note:** To use Secure Print and Proof Print, you must have a minimum of 256 MB memory installed and the RAM Disk must be enabled. For instructions about enabling options, see Enabling Options on page 134.
Print After Checking Printing Result - Proof Print

When the hard drive or additional memory is added, you can use the proof print feature.

**Note:** The data stored in the RAM disk is erased when the printer is switched off.

**About Proof Print**

Proof Print is a feature that allows you to store the print data of multiple copies in the memory, print out only the first set to check the print result and if satisfactory, print the remaining copies from the control panel.

Proof print data that has become redundant can be deleted using the control panel. See Printing from the Control Panel on page 88.

To delete all proof print data that has become redundant, see System Setup on page 98.

**Configuring Proof Print**

The procedure to configure Proof Print using the PCL or PostScript print driver is as follows.

First of all, carry out the proof print settings at the computer and send data to the printer for printing. Then, carry out the output procedure at the printer to output the printed pages.

**Printing from the Computer**

**Note:** Ensure the RAM disk is set to available. You can find this under the Options tab using the PCL print driver or the Device Settings tab using the PostScript print driver. The RAM disk also needs to be enabled via the control panel. For instructions about enabling options, see Enabling Options on page 134.

1. From the **File** menu, select **Print**.
2. Select the printer, and click **Preferences** or **Properties**.
3. Click the **Paper/Output** tab.
4. In the **Job Type** field, select **Proof Print**.
5. Click the **Setup** button.
6. In the **Username** field, enter your user name.
7. If you want to use a specified document name to access the document from the control panel:
   a. In the **Retrieve Document Name** field, select **Enter Document Name**.
   b. In the **Document Name** field, enter the name that will appear on the control panel.
8. If you want the printer to automatically name the document using a time stamp, in the **Retrieve Document Name** field, select **Use Existing Name**.
9. Click **OK** twice to accept the **Secure Print** settings, and then click **Print** to send the job. Now follow the instructions in Printing from the Control Panel, below, to continue printing the job.
Printing from the Control Panel

This section explains the procedure to print and delete data stored in the printer by Proof Print.

1. On the control panel, press the Back Arrow button to display the Walk-Up Features menu.
2. Select Proof Print, and then press the OK button.
3. Select your user name, and then press the OK button.
4. If you submitted more than one proof print job, select the name of the job that you want to print, and then press the OK button.
5. Select Del after Print or Print and Save, and then press the OK button to print the job.
6. Scroll to the desired number of copies, and then press the OK button to print the job.

Note: The user ID displayed (up to 8 characters) is the User ID set in the Proof Print dialog box of the Paper/Output tab of the print driver.

The document name displayed (up to 12 characters) is the Document Name set in the Proof Print dialog box of the Paper/Output tab of the print driver.

Note: To use Secure Print and Proof Print, you must have a minimum of 256 MB memory installed and the RAM Disk must be enabled. For instructions about enabling options, see Enabling Options on page 134.
Using the Control Panel Menus

This chapter includes:

- Control Panel Menus on page 91
- Description of Menu Items on page 93
- Menu List on page 105
# Control Panel Menus

This section includes:

- **Menu Configuration** on page 91
- **Changing Menu Settings** on page 92

## Menu Configuration

The menus that can be accessed from the control panel are as follows:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Pages</td>
<td>Use the Information Pages menu to print various types of reports and lists.</td>
</tr>
</tbody>
</table>
| Admin Menu     | - Network Setup  
                  |   Use this menu to configure the network settings for the printer.  
                  | - USB Setup  
                  |   Use this menu to configure the USB interface.  
                  | - System Setup  
                  |   Use this menu to make the printer operation settings, such as for alarm  
                  |   and Power Saver mode.  
                  | - Maintenance Mode  
                  |   Use this menu to initialize the NVM, or to adjust the configurations for  
                  |   each type of paper.  
                  | - PCL Setup  
                  |   Use this menu to configure the PCL settings.  
                  | - PostScript Setup  
                  |   Use this menu to configure the PostScript settings.  
                  | - Control Panel  
                  |   Use this menu to specify whether to limit the menu operations with a panel  
                  |   lock.  
| Tray Settings  | Use the Tray Settings menu to define the print media loaded in each tray. |
| Billing Meters | Use the Billing Meters menu to display the printed paper counts on the control  
                  |   panel. |

Each menu is configured in different levels. Set the printer settings by selecting the objective menus or items structure level.

*See also:*

  - [Description of Menu Items](#) on page 93
Changing Menu Settings

Changing the Power Saver Time

In this example, you set the transitional time to the Power Saver Mode.

1. To display the menu screen, press the Menu button at the print screen.
2. Press the Up Arrow or Down Arrow button until Admin Menu is displayed, and then press the Forward Arrow or OK button.
3. Press the Up Arrow or Down Arrow button until System Setup is displayed, and then press the Forward Arrow or OK button.
4. Press the Up Arrow or Down Arrow button until PowerSaver Time is displayed, and then press the Forward Arrow or OK button.
5. Press the Up Arrow or Down Arrow button to change the number of minutes that the printer will wait before entering Power Saver mode.
6. Press the OK button to confirm your settings. The settings that have been confirmed are displayed with the affix "*".
7. Press the Menu button to quit the menu operation and return to the print screen.
8. Ready to print.

Note: If you want to change values after you have confirmed them by pressing the OK button, you need to set them from the start again.

Initializing Configured Values

Display the item you want to initialize, and then press both the Up Arrow and Down Arrow buttons at the same time.

Once the change process is completed, the factory defaults will be displayed. Press the OK button to confirm the value.
Description of Menu Items

This section includes:

- Tray Settings on page 93
- Information Pages on page 95
- Billing Meters on page 96
- Admin Menu on page 96

Tray Settings

There are three submenus under the Tray Settings menu: Tray 1 (MPT), Tray 2, and Tray 3. You can set paper size and paper type for each tray under these menus. (Display Pop-up and MPT Mode can only be set for Tray 1 (MPT).)

Tray 3 is displayed only when the optional sheet feeder is installed.

The settings menu for Tray 1 (MPT) is displayed only when the MPT Mode is set to Panel Specified.

Common Settings for Tray 1 (MPT), Tray 2, and Tray 3

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Type</td>
<td>Specifies the type of paper loaded in each tray.</td>
</tr>
<tr>
<td></td>
<td>- Tray 1 (MPT) (default: Thin Card Stock)</td>
</tr>
<tr>
<td></td>
<td>- Tray 2 (default: Plain)</td>
</tr>
<tr>
<td></td>
<td>- Tray 3 (default: Plain)</td>
</tr>
<tr>
<td></td>
<td>For details, refer to Setting Paper Types and Sizes on page 50.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Specify the paper size and orientation for each tray.</td>
</tr>
<tr>
<td></td>
<td>- Tray 1 (MPT) (default: Driver Size)</td>
</tr>
<tr>
<td></td>
<td>- Tray 2 (default: Auto)</td>
</tr>
<tr>
<td></td>
<td>- Tray 3 (default: Auto)</td>
</tr>
<tr>
<td></td>
<td>For details, refer to Setting Paper Types on page 50.</td>
</tr>
</tbody>
</table>
Settings Exclusive to Tray 1 (MPT)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Popup</td>
<td>Specifies whether or not to display the message that prompts you to set the paper size and type every time you load paper in the Tray 1 (MPT). When you select On, the message that prompts you to set the paper size and type is displayed. The default is Off.</td>
</tr>
<tr>
<td>MPT Mode</td>
<td>Specifies the way to set the paper type and size settings to be loaded in Tray 1 (MPT).</td>
</tr>
<tr>
<td></td>
<td>• Panel Specified (default) You can specify the paper type and size settings on the control panel. Printing can be done only when the settings on the print driver matches the settings on the control panel. When a mismatch of paper sizes occurs, follow the instructions displayed on the control panel.</td>
</tr>
<tr>
<td></td>
<td>• DriverSpecified You cannot specify the settings on the control panel. Printing is done using the settings on the print driver.</td>
</tr>
</tbody>
</table>

When the size or type of paper that is loaded is different from the setting, the print quality may fall or paper may jam. Specify the correct paper type and size.

When installing the optional sheet feeders if Paper Tray is set to Auto on the print driver, the feeding tray is automatically specified according to the setting on the control panel. Also, when the paper size and type setting for each tray is the same, printing continues by changing the feeding tray if the paper in the specified tray has run out.
Information Pages

Prints various types of reports and lists.

- The information pages are printed on A4 size paper. Load A4 size paper into the tray.
- For the procedure for printing information pages, refer to Printing Information Pages on page 95.

<table>
<thead>
<tr>
<th>Reports</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Map</td>
<td>Prints a map of the control panel menus.</td>
</tr>
<tr>
<td>Demo Page</td>
<td>You can print a sample of the document to check the printer’s performance.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Prints status of the printer, such as hardware configuration and network information. Print this report to check whether optional accessories have been correctly installed.</td>
</tr>
<tr>
<td>PCL Fonts List</td>
<td>Prints information on PCL fonts and samples of these fonts.</td>
</tr>
<tr>
<td>PCL Macro List</td>
<td>Prints a list of PCL macros.</td>
</tr>
<tr>
<td>PS Fonts List</td>
<td>Prints information on PS fonts and samples of these fonts.</td>
</tr>
<tr>
<td>Job History</td>
<td>Prints information on printing result, such as whether data from the computer has been printed correctly. The status of a maximum of 22 jobs can be printed on the Job History Report. Use the control panel to set whether to print the Job History Report automatically for every 22 jobs completed. For details, refer to System Setup on page 98.</td>
</tr>
<tr>
<td>Error History</td>
<td>Prints information of up to the latest 42 errors that occurred in this printer.</td>
</tr>
<tr>
<td>Print Meter</td>
<td>Prints a print meter.</td>
</tr>
<tr>
<td>Stored Documents</td>
<td>Prints a list of documents stored in the printer when using the secure print and sample print feature. For details, refer to Printing Confidential Documents - Secure Print on page 85 and Print After Checking Printing Result - Proof Print on page 87.</td>
</tr>
</tbody>
</table>

Printing Information Pages

Information pages are printed from the control panel.

1. Press the Menu button to display the Menu screen.
2. Press the Up Arrow or Down Arrow button until Information Pgs is displayed, and then press the Forward Arrow or OK button.
3. Press the Up Arrow or Down Arrow button until the desired report/list is displayed, and then press the OK button. The selected information page is printed.
Billing Meters

Displays the number of processed print jobs on the control panel. The meter is divided according to the color modes.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Impressions</td>
<td>Displays the total number of pages printed in color.</td>
</tr>
<tr>
<td>Black Impressions</td>
<td>Displays the total number of pages printed in black/white.</td>
</tr>
<tr>
<td>Total Impressions</td>
<td>Displays the total number of pages printed.</td>
</tr>
</tbody>
</table>

See also:
Checking Page Counts on page 149

Admin Menu

This menu contains these submenus:

- Network Setup
- USB Setup
- System Setup
- Maintenance Mode
- PCL Setup
- PostScript Setup
- Control Panel
**Network Setup**

Specifies printer settings affecting jobs sent to the printer through a network port.

- The settings in the Network Setup menu cannot be set when entering this menu during printing.
- You need to restart the printer to activate the new settings. After making the settings, turn off the printer and then turn it on again.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Ethernet | Specifies the communication speed and the modes of Ethernet.  
  - Auto (default)  
    Automatically changes between 10M Half Duplex, 10M Full Duplex, 100M Half Duplex, and 100M Full Duplex.  
  - 10M Base Half  
  - 10M Base Full  
  - 100M Base Half  
  - 100M Base Full |
| TCP/IP   | Specifies the settings to use the TCP/IP protocol.  
  Protocol Set  
  - Enable when using the protocol. When Disable is selected, the protocol cannot be activated.  
  - LPR (default: Enable)  
  - Port 9100 (default: Enable)  
  - IPP (default: Enable)  
  - SMB TCP/IP  
  - SMB NetBEUI  
  - FTP (default: Enable)  
  - WSD (default: Enable)  
  - SNMP (default: Enable)  
  - Email Alerts (default: Enable)  
  - CentreWare IS (default: Enable)  
  - Bonjour (mDNS) (default: Enable)  
  IPP is displayed only when the optional multi protocol card is installed. |
| Host Access List | Specifies blocking the reception of data from certain IP addresses. |
| Reset Defaults | Initializes network data stored in NVM. The NVM is a nonvolatile memory that stores the printer settings even after power off. Initializing the NVM will revert the value for each item of the Wired Network menu to default. |
| Adobe Protocol | Specifies the PostScript communication protocol: Standard, BCP, TBCP, Binary, or Auto. |
**USB Setup**

Use USB Setup for setting the USB port’s status.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Status</td>
<td>Select either Enable or Disable.</td>
</tr>
<tr>
<td>Adobe Protocol</td>
<td>Specifies the PostScript communication protocol: Standard, BCP, TBCP, Binary, or Auto.</td>
</tr>
</tbody>
</table>

**System Setup**

System Setup menu is used to make the printer operation settings, such as for alarm and power saver mode.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| PowerSaver Timer   | Specify the transitional time to Power Saver between 5 and 60 minutes in increments of 1 minute.  
|                    | • 5 min. to 60 min. (default: 30 min.)  
|                    | • For details, refer to **Power Saver Mode** on page 27                    |
| Audio Tones        | Specifies whether to turn on the alarm when an error occurs in the printer. You cannot adjust the sound volume.  
|                    | • Control Panel (default: Off)  
|                    | • Invalid Key (default: Off)  
|                    | • Machine Ready (default: Off)  
|                    | • Job Complete (default: Off)  
|                    | • Fault Tone (default: Off)  
|                    | • Alert Tone (default: Off)  
|                    | • Out of Paper (default: Off)  
|                    | • Low Toner Alert (default: Off)  
|                    | • Base Tone (default: Off)  
| Fault Time-Out     | Sets the fault time-out function.                                            |
| Time-Out           | You can cancel a printing process when it goes beyond a set time period. Set the time until the print job is canceled. When this timeout expires, the print job is canceled.  
|                    | • 5 sec. to 300 sec. (default: 30 sec.)  
|                    | Specifies the amount of time in increments of 1 second the printer waits for additional data before it cancels the job.  
|                    | • Off  
<p>|                    | Cannot cancel.                                                             |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Log Print</td>
<td>Specifies whether to automatically print information about the printed data that has been processed in the printer (Job History Report).</td>
</tr>
</tbody>
</table>
|                    | • **Off** (default)  
|                    | Select this if you do not want to print the Job History Report automatically even if the number of print jobs exceeds 22.               |
|                    | • **On**  
|                    | Automatically prints a report when the number of print jobs reaches 22.                                                                      |
|                    | • You cannot set this during printing.                                                                                                       |
|                    | • You can print the **Job History Report** from the **Information Pgs** menu.                                                                  |
|                    | • You need to restart the printer to activate the new settings. After making the settings, turn off the printer and then turn it on again.    |
| Print ID           | Select this to print the user ID on a specified position.                                                                                     |
|                    | • **Off** (default)  
|                    | User ID is not printed.                                                                                                                         |
|                    | • **Top Left**  
|                    | Prints the user ID on the top left of the sheet of paper.                                                                                     |
|                    | • **Top Right**  
|                    | Prints the user ID on the top right of the sheet of paper.                                                                                     |
|                    | • **Bottom Left**  
|                    | Prints the user ID on the bottom left of the sheet of paper.                                                                                   |
|                    | • **Bottom Right**  
|                    | Prints the user ID on the bottom right of the sheet of paper.                                                                                   |
| Print Text         | Specifies whether the printer outputs PDL data, which is not supported by the printer, as text when the printer receives it. Text data is printed on A4 or Letter size paper. |
|                    | • **Off** (default)  
|                    | Does not print the received data.                                                                                                             |
|                    | • **On**  
|                    | Prints the received data as text data.                                                                                                         |
| Banner Sheet       | Specifies the settings for the banner sheet.                                                                                                  |
|                    | • **Insert Position** (default: Off)  
|                    | Selects the position to output the banner sheet from Off, Front, Back, and Front & Back. When Off is selected, the banner sheet is not printed. |
|                    | • **Specify Tray** (default: Tray 1 (MPT))  
|                    | Specifies the tray from which the banner sheet is output: Tray 1 (MPT), Tray 2, or Tray 3.                                                      |
| Odd Page 2 Sided   | If the optional duplex mode is installed, use to select the process for the last odd page in a 2-sided print job. Select either 1 Sided or 2 Sided. |
| Start Up Page      | Select On to print a Configuration page after starting the printer. Select Off to turn this function off.                                      |
| Language           | Specifies the language that is displayed on the control panel and Information pages.                                                           |
### Description of Menu Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| RAM Disk        | Allocates memory to the RAM Disk file system for the secure print, collating jobs, and sample print features.  

- **Enable**
  Allocates memory for using the secure print and proof print features.  

- **Disable** (default)
  Does not allocate memory for using the secure print and proof print features.  

  This item is displayed when at least 256 MB of memory are added. |
| Size Mismatch   | Specifies the action to take when the driver paper size settings do not match the control panel size settings.  

- **Off** (default)
  Select this to display a message prompting you to load paper.  

- **Larger Size**
  Select this to replace the paper with a longer size paper before printing in 100% magnification ratio.  

- **Nearest Size**
  Select this to replace the paper with the nearest size paper before printing in 100% magnification ratio.  

- **Tray 1 (MPT) Feed**
  Select this to print on paper loaded in Tray 1 (MPT).  

  If a computer issues the instruction about paper selection, it overwrites this setting. |
| mm/inch         | Set the units for the custom paper size to millimeters (mm) or inches.  

- **millimeter (mm)** (default)
  The paper size is displayed in millimeters  

- **inch (”)**
  The paper size is displayed in inches. |
## Maintenance Mode

Use this menu to initialize the NVM, or to adjust the configurations for each type of paper.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FW Version</td>
<td>Displays the current firmware version.</td>
</tr>
<tr>
<td>Auto Regi Adjust</td>
<td>Adjust the color registration automatically. Selecting On adjusts the color registration automatically. The default is On.</td>
</tr>
<tr>
<td>Adjust ColorRegi</td>
<td>Correct the color registration manually. For details, refer to Color Registration on page 111.</td>
</tr>
</tbody>
</table>
|                    | • Auto Adjust  
|                    | Correct the color registration.                                                                                                              |
|                    | • Color Regi Chart  
|                    | Prints the correction chart.                                                                                                                 |
|                    | • Enter Number  
|                    | Enter the number to correct the registration.                                                                                                 |
| Init PrintMeter    | Initializes the print meter.                                                                                                                 |
| Initialize NVM     | Initializes the settings stored in the NVM except for the network settings. The NVM is a nonvolatile memory that stores the printer settings even after the power is turned off. After executing this function and restarting the printer, all the menu parameters are reset to their default values.  
|                    | • You cannot execute this menu during printing.                                                                                              |
|                    | • You need to restart the printer to activate this setting. After making the setting, turn off the printer and then turn it on again.         |
| Clear Storage      | Clears stored information.                                                                                                                  |
| Format HDD         | Formats the hard drive.                                                                                                                      |
**PCL Setup**

Specifies the settings for the PCL.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Tray</td>
<td>Specifies the paper tray to be used for printing.</td>
</tr>
</tbody>
</table>
|               | • **Auto** (default)  
|               | The tray is selected automatically when print data is sent. |
|               | • **Tray 1 (MPT)**  
|               | • **Tray 2**  
|               | • **Tray 3**  |
| Paper Size    | Specifies the paper size to be printed. |
|               | • **A4**  
|               | • **B5**  
|               | • **A5**  
|               | • **8.5x11**  
|               | • **8.5x13**  
|               | • **8.5x14**  
|               | • **7.25x10.5**  
|               | • **Monarch Env**  
|               | • **DL Envelope**  
|               | • **C5 Envelope**  
|               | • **Com 10 Env**  
|               | • **New Custom Size**  |
| Orientation   | The paper printing direction can be selected from Portrait and Landscape. The default is Portrait. |
| 2 Sided       | Specifies the 2-sided printing settings: |
|               | • **2-Sided Print**  
|               | Specifies whether to perform 2-sided printing. The default is Off. |
|               | • **Binding Edge**  
|               | **Specifies the binding direction from** Flip Long Edge or Flip Short Edge.  
|               | **The default is** Flip Long Edge.  |
| Font          | Specifies the font used. The default is Courier. |
| Symbol Set    | Specifies the font for symbols. The default is ROMAN-8. |
| Font Size     | Specifies the font size. The default is 12.00. You can specify a value between 4.00 and 50.00 in increments of 0.25. |
| Font Pitch    | Specifies the character spacing. The default is 10.00. You can specify a value between 6.00 and 24.00 in increments of 0.01. |
| Form Line     | Specifies the form line (the number of lines per form). The default is 60. You can specify a value between 5 and 128 in increments of 1. |
| Quantity      | Specifies the copies to be printed between 1 to 999. The default is 1. |
**Image Enhance**
Selects whether to perform image enhancement. Image enhancement is a feature that makes the boundary line between black and white smoother to decrease jags and enhance the visual appearance. The default is On.

**Hex Dump**
Specifies whether to print the data sent from a computer in the ASCII code corresponding to the hexadecimal notation format in order to check the data contents. The default is Disable.

**Draft Mode**
Specifies whether to print in draft mode. The default is Disable.

**Line Termination**
Sets the line termination.
- **Off** (default)
  The line termination command is not added. 
  CR=CR, LF=LF, FF=FF
- **Add-LF**
  The LF command is added. 
  CR=CR-LF, LF=LF, FF=FF
- **Add-CR**
  The CR command is added. 
  CR=CR, LF=CR-LF, FF=CR-FF
- **CR-XX**
  The CR and LF commands are added. 
  CR=CR-LF, LF=CR-LF, FF=CR-FF

**Default Color**
Specifies the color mode to Color or Black. This settings is used when the color printing mode setting is not specified for the print job that is sent to the printer.
- **Black** (default)
  Prints in black and white mode.
- **Color**
  Prints in the color mode.

---

**PostScript Setup**
Specifies the PostScript settings.

**Item** | **Description**
--- | ---
PS Error Report | Turns error reporting on or off.
PS Job Time-Out | Turns the time-out off, or selects the length of time before timing-out.
Init PS Disk | Initializes the HDD area that PostScript uses.
Paper Select Mode | Selects a paper tray.
Default Color | Sets the default as **Color** or **Black**.
**Control Panel**

Specifies whether to limit menu operations with a password to avoid changing the printer settings by accident.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Lock</td>
<td>Specifies whether to limit the menu operations with a password. Selecting On requires the operator to enter the password. If On is set, then you must enter the password to use the Admin Menu. The default is Off.</td>
</tr>
</tbody>
</table>
Menu List

The Menu Map helps you navigate the control panel menus. To print the Menu Map:

1. On the control panel, press the Menu button, select Information Pgs, and then press the OK button.
2. Select Menu Map, and then press the OK button to print.

Note: Print the Menu Map to see other information pages available for printing.

Main operation and buttons on the control panel

<table>
<thead>
<tr>
<th>Function Description</th>
<th>Button(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display/close the Menu screen</td>
<td>Menu button</td>
</tr>
<tr>
<td>Switch between the menu levels</td>
<td>Forward Arrow button (moves one level downwards) or Back Arrow button (moves one level upwards)</td>
</tr>
<tr>
<td>Switch between menu or items in the same level</td>
<td>Up Arrow button (displays the previous menu or item) or Down Arrow button (displays the next menu or item)</td>
</tr>
<tr>
<td>Move the cursor (_) of the setting value the right or left</td>
<td>Forward Arrow button (moves to the right) or Back Arrow button (moves to the left)</td>
</tr>
<tr>
<td>Confirm setting</td>
<td>OK button</td>
</tr>
<tr>
<td>Reset settings to default value</td>
<td>Press Up Arrow and Down Arrow button at the same time.</td>
</tr>
</tbody>
</table>

See also: Description of Menu Items on page 93
This chapter includes:

- **Print-Quality Problems** on page 107
- **Color Registration** on page 111
Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table to correct the problem.

If the print quality does not improve after carrying out the appropriate action, contact Xerox Customer Support or your reseller.

Note: To enhance print quality, print cartridges for many models of equipment have been designed to cease functioning at a predetermined point.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faded printouts</td>
<td>Multiple colors faded:</td>
</tr>
<tr>
<td></td>
<td>• The print cartridges are not Xerox print cartridges.</td>
</tr>
<tr>
<td></td>
<td>Verify that the print cartridges (C/M/Y/K) meet specifications, and replace if necessary.</td>
</tr>
<tr>
<td></td>
<td>• The paper is outside the recommended specification range.</td>
</tr>
<tr>
<td></td>
<td>Replace the media with a recommend size and type, and confirm that your control panel settings are correct. See About Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>• The paper is damp.</td>
</tr>
<tr>
<td></td>
<td>Replace the paper. See About Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>• The transfer unit is old or damaged.</td>
</tr>
<tr>
<td></td>
<td>Replace the transfer unit.</td>
</tr>
<tr>
<td></td>
<td>• The high-voltage supply is defective.</td>
</tr>
<tr>
<td></td>
<td>See the Xerox Support website, <a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a>, for assistance.</td>
</tr>
<tr>
<td></td>
<td>Only one color faded:</td>
</tr>
<tr>
<td></td>
<td>• Check the condition of the print cartridge, and replace as necessary.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Reason/Action</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Stray black dots or white areas (drop outs) | - The paper is outside the recommended specification range.  
Replace the paper with a recommended size and type, and confirm that your control panel settings are correct. See About Paper on page 48.  
- The transfer unit is old or damaged.  
Replace the transfer unit.  
- The print cartridges are not Xerox print cartridges.  
  - Check the condition of the print cartridge, and replace as necessary.  
  - Verify that the print cartridges (C/M/Y/K) meet specifications, and replace if necessary. |
| Vertical black or color streaks  | - Multiple colored streaks or lines:  
  - The transfer unit, or fuser, is old or damaged.  
  Check the condition of the transfer unit and fuser, and replace as necessary.  
  - The print cartridges are not Xerox print cartridges.  
  Verify that the print cartridges (C/M/Y/K) meet specifications, and replace if necessary.  
- Streak in only one color:  
  - Check the condition of the print cartridge, and replace as necessary.  
  Verify that the print cartridge meets specifications, and replace if necessary. |
| Recurring smudges               | - Dirt in the paper path.  
Print several blank sheets.  
- The paper is outside the recommended specification range.  
Replace the paper with a recommended size and type, and confirm that your control panel settings are correct. See About Paper on page 48.  
- The transfer unit, or fuser, is old or damaged.  
Check the condition of the transfer unit and fuser, and replace as necessary. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toner smears when rubbed</td>
<td>The paper is damp. Replace the paper. See About Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range. Replace the paper with a recommended size and type, and confirm that your print driver settings are correct. See About Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The print cartridges are not Xerox print cartridges. Verify that the print cartridges (C/M/Y/K) meet specifications, and replace if necessary.</td>
</tr>
<tr>
<td></td>
<td>The fuser is old or damaged. Replace the fuser.</td>
</tr>
<tr>
<td>Blank pages</td>
<td>Two or more sheets may be feeding at once. Remove the paper stack from the tray, fan it, and reinsert it.</td>
</tr>
<tr>
<td></td>
<td>The print cartridges are not Xerox print cartridges. Verify that the print cartridges (C/M/Y/K) meet specifications, and replace if necessary.</td>
</tr>
<tr>
<td></td>
<td>The transfer unit is old or damaged. Replace the transfer unit.</td>
</tr>
<tr>
<td></td>
<td>The high-voltage supply is defective. See the Xerox Support website, <a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a>, for assistance.</td>
</tr>
<tr>
<td>Hair-like marks appear in or around black half-tone printing Shadows appear around areas of dense black printing</td>
<td>The paper was left unwrapped for a long time (especially in a dry environment). Replace the paper. See About Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range. Replace the paper with a recommended size and type, and confirm that your print driver settings are correct. See About Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The transfer unit is old or damaged. Replace the transfer unit.</td>
</tr>
<tr>
<td>Color around the edge of printing is incorrect</td>
<td>The color registration is incorrect. Adjust the color registration. See Color Registration on page 111.</td>
</tr>
<tr>
<td>Colored dots are printed at regular intervals (about 28 mm)</td>
<td>The print cartridge is dirty. Clean the print cartridge.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Reason/Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Partial blanks, creased paper, or blotted printing</td>
<td>- The paper is damp. Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>- The paper is outside the recommended specification range. Replace the paper with a recommended size and type. See About Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>- The transfer unit, or fuser, is not installed correctly. Reinstall the transfer unit and/or fuser.</td>
</tr>
<tr>
<td></td>
<td>- The print cartridges are not Xerox print cartridges. Verify that the print cartridges (C/M/Y/K) meet specifications, and replace if necessary.</td>
</tr>
<tr>
<td></td>
<td>- Condensation inside the printer causes partial blanks or creased paper. Turn the printer on, and leave it on, for at least one hour to get rid of the condensation. If the problems still occur, see the Xerox Support website, <a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a>, for assistance.</td>
</tr>
<tr>
<td>Vertical blanks</td>
<td>- The laser is being blocked. Remove the print cartridges and clean all debris from the laser len(s) with a lint free cloth.</td>
</tr>
<tr>
<td></td>
<td>- The transfer unit, or fuser, is old or damaged. Check the condition of the transfer unit and fuser, and replace as necessary.</td>
</tr>
<tr>
<td></td>
<td>- The print cartridges are not Xerox print cartridges. Check the condition of the print cartridge, and replace as necessary. Verify that the print cartridges (C/M/Y/K) meet specifications, and replace if necessary.</td>
</tr>
<tr>
<td>Slanted printing</td>
<td>- The paper guides in Tray 2, Tray 3, or Tray 1 (MPT) are not set correctly. Reset the paper guides in Tray 2, Tray 3, or Tray 1 (MPT). See Loading Paper in Trays 2-3 on page 55.</td>
</tr>
<tr>
<td>Horizontal bands, approximately 22 mm wide, appear vertically every 73 mm</td>
<td>- The print cartridge has been exposed to too much light; possibly from leaving the front door open too long. Replace the print cartridge.</td>
</tr>
<tr>
<td>Colors are blurry or there is white area around objects</td>
<td>- Color to color alignment is not correct. Use the automatic color registration. See Color Registration on page 111.</td>
</tr>
</tbody>
</table>
Color Registration

Color registration can be adjusted by the printer automatically, or you can manually adjust it. Color registration should be adjusted any time the printer is moved.

For more information, see Checking Page Counts on page 149.

Automatic Color Registration Adjustment

Use the following procedure to perform automatic color registration adjustment.

Note: An automatic color registration adjustment is performed every time a new print cartridge is installed.

1. Press the Menu button to display the Menu screen.
2. Press the Up Arrow or Down Arrow button until Admin Menu is displayed, and then press the Forward Arrow or OK button.
3. Press the Up Arrow or Down Arrow button until Maintenance Mode is displayed, and then press the Forward Arrow or OK button.
4. Press the Up Arrow or Down Arrow button until Adjust ColorRegi is displayed, and then press the Forward Arrow or OK button.
5. Press the Up Arrow or Down Arrow button until Auto Adjust is displayed, and then press the Forward Arrow or OK button.
6. Press the OK button when Are you sure? is displayed.

The adjustment is complete when Ready is displayed on the control panel.

Manual Color Registration Adjustment

You can fine tune color registration by performing a manual adjustment of color registration.

Printing the Color Registration Correction Chart

1. Press the Menu button to display the Menu screen.
2. Press the Up Arrow or Down Arrow button until Admin Menu is displayed, and then press the Forward Arrow or OK button.
3. Press the Up Arrow or Down Arrow button until Maintenance Mode is displayed, and then press the Forward Arrow or OK button.
4. Press the Up Arrow or Down Arrow button until Adjust ColorRegi is displayed, and then press the Forward Arrow or OK button.
5. Press the Up Arrow or Down Arrow button until Color Regi Chart is displayed, then press the OK button. The Color Registration Correction Chart is printed. When printing is finished, the print screen is displayed again.
Color Registration

Determining Values

From the lines to the right of the Y (yellow), M (magenta), and C (cyan) pattern, find the values of the straightest lines.

When “0” is the value nearest the straightest line, you do not need to adjust the color registration. When the value is not “0”, follow the procedure outlined in “Entering Values”.

Note: You can also use the densest colors of the grid to find the straightest lines. The colors printed at the highest density are those next to the straightest lines.

Entering Values

Using the control panel, enter the values that you found in the Color Registration Correction Chart to make adjustments.

1. Press the Menu button to display the Menu screen.
2. Press the Up Arrow or Down Arrow button until Admin Menu is displayed, then press the Forward Arrow or OK button.
3. Press the Up Arrow or Down Arrow button until Maintenance Mode is displayed, then press the Forward Arrow or OK button.
4. Press the Up Arrow or Down Arrow button until Adjust ColorRegi is displayed, then press the Forward Arrow or OK button.
5. Press the Up Arrow or Down Arrow button until Enter Number is displayed, then press the Forward Arrow or OK button.
6. Press the Up Arrow or Down Arrow button until you reach the value displayed on the chart.
7. Press the Forward Arrow button once and move the cursor to the next value.
8. Repeat steps 6 and 7 to continue adjusting the color registration.
9. Press the OK button twice.
10. Press the Up Arrow or Down Arrow button until Color Reg Chart displays, then press the Forward Arrow or OK button. The Color Registration Correction Chart is printed with the new values. When printing is finished, the print screen is displayed again.
11. Color registration adjustment is complete when the straightest Y (yellow), M (magenta), and C (cyan) lines are next to the “0” line.
   If “0” is not next to the straightest lines, determine the values and adjust again.

Note: After printing the Color Registration Correction Chart, do not turn off the printer until the printer motor has stopped running.
Enabling/Disabling Automatic Color Registration

Use the following procedure to enable/disable automatic color registration when a new print cartridge is installed.

1. Press the Menu button to display the Menu screen.
2. Press the Up Arrow or Down Arrow button until Admin Menu is displayed, and then press the Forward Arrow or OK button.
3. Press the Up Arrow or Down Arrow button until Maintenance Mode is displayed, and then press the Forward Arrow or OK button.
4. Press the Up Arrow or Down Arrow button until Auto Regi Adj is displayed, and then press the Forward Arrow or OK button.
5. Press the Up Arrow or Down Arrow button to turn automatic color registration On or Off.
Run Black

When a color laser printer runs out of toner, users are typically unable to print until a new toner cartridge is installed. When a Phaser 6280 runs out of cyan, magenta, or yellow toner it can still print in black and white. This feature is known as “Run Black.”

To activate Run Black mode if a color toner runs out in the middle of a print job:

1. Cancel the job.
2. Click File > Print > Preferences or Properties.
3. Click the Paper / Output tab, and under Output Color, select Black and White.
4. Resend your print job.

**Note:** All color toner cartridges must remain installed in the printer when switching to Run Black mode.
Troubleshooting

This chapter includes:

- Paper Jams on page 116
- Problems With the Printer on page 131
- Control Panel Error Messages on page 135
- Getting Help on page 139

See also:
- Troubleshooting video tutorials at www.xerox.com/office/6280support
- Print-Quality Problems on page 107
Paper Jams

This section includes:

- Preventing and Clearing Paper Jams on page 116
- Paper Jams in Tray 1 (MPT) on page 117
- Paper Jams in the Paper Tray on page 120
- Paper Jams at the Fuser on page 123
- When Long Paper Jams on page 124
- Paper Jams at the Duplex Unit on page 125
- Paper Jams in the Optional Sheet Feeder on page 127

See also:
- User Safety on page 8

Preventing and Clearing Paper Jams

To reduce the occurrence of paper jams, follow the guidelines and instructions in Printing Basics on page 45. It includes information about supported paper and media, guides for usage, and instructions for properly loading paper in the trays.

Caution: When removing jammed paper, make sure that no pieces of torn paper are left in the printer. A piece of paper remaining in the printer can cause a fire. If a sheet of paper is wrapped around the heat roller, or when clearing a jammed paper that is difficult or impossible to see, do not try to remove it by yourself. Turn off the printer immediately, and refer to the Xerox Support website, www.xerox.com/office/6280support.

Warning: The fuser and the surrounding area are hot and can cause burns.
Paper Jams in Tray 1 (MPT)

Follow this procedure to remove paper jammed in Tray 1 (MPT).

1. Pull the jammed paper out of Tray 1 (MPT), and remove any remaining paper from the tray.

2. Close Tray 1 (MPT).

3. Push the button and open the front cover.

**Warning:** Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.
4. Carefully remove any jammed paper in the printer. Confirm that there are no scraps of paper left inside.

**Caution:** Prolonged exposure to light may damage the print cartridge.

5. Close the front cover.

6. Remove the tray from the printer.
7. Carefully pull out any jammed paper remaining inside the printer.

8. Insert the tray into the printer and push until it stops.

**Caution:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
Paper Jams in the Paper Tray

Follow the procedure below to remove paper jammed in the paper tray.

1. Gently remove the tray from the printer.

2. Remove all the jammed and/or creased paper from the tray.
3. If there is jammed paper remaining inside the printer, pull it out carefully to avoid tearing it.

4. Press the button and open the front cover. Remove any scraps of paper remaining inside the printer.

Caution: Prolonged exposure to light may damage the print cartridge.

Warning: Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.
5. Close the front cover.

6. Insert the tray into the printer, and push until it stops.

**Caution:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
Paper Jams

Paper Jams at the Fuser

1. Press the button and open the front cover.

2. Lift the levers at both ends of the fuser (1), and remove the jammed paper (2). If the paper is torn, remove any scraps of paper remaining inside the printer.

   **Warning:** Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.

   **Caution:** Prolonged exposure to light may damage the print cartridge.
3. Open the cover of the fuser and remove the jammed paper.

4. Close the front cover.

When Long Paper Jams

When long paper (longer than 356 mm) jams inside the printer, cut the paper as needed, then remove it in the proper way depending on the place that the paper jam occurs.

**Caution:** If it is difficult to open the front cover, do not force it. Turn the power off immediately. Refer to the Xerox Support website, [www.xerox.com/office/6280support](http://www.xerox.com/office/6280support), for assistance.
Paper Jams at the Duplex Unit

1. Push the button and open the front cover.

   Warning: Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.

2. Carefully pull out the jammed paper from the duplex unit. If jammed paper cannot be found, go to the next step.

   Caution: Prolonged exposure to light may damage the print cartridge.
3. Hold the knobs of the transfer unit as shown in the following illustration and open the unit fully.

4. Remove the jammed paper. Confirm that there are no scraps of paper left inside the transfer belt unit.

5. Close the transfer belt unit.
6. Close the front cover.

**Paper Jams in the Optional Sheet Feeder**

1. Open the trays until you find the jammed paper.

   **Note:** Paper jammed in the lower tray can block the trays above it, preventing you from opening them. Look for the jammed paper sequentially, starting with the lowest tray.
2. Remove all jammed and/or creased paper from the tray.

3. Pull the jammed paper out carefully to avoid tearing it. If the paper is torn, confirm that there are no scraps of paper remaining inside the printer.
4. Push the button and open the front cover. Confirm that there are no scraps of paper remaining inside the printer.

Caution: Prolonged exposure to light may damage the print cartridge.

Warning: Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.

5. Close the front cover.
6. Insert the trays into the printer. Push the trays in until they stop.

**Caution:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
Problems With the Printer

If you encounter a problem with your printer, use the following table to troubleshoot and fix the problem. For additional troubleshooting information, see Getting Help on page 139.

**Warning:** Never open or remove printer covers that are secured with screws unless specifically instructed in the manual. A high voltage component can cause electric shock. Do not try to alter the printer configuration, or modify any parts. An unauthorized modification can cause smoke or fire.

**Caution:** Probable causes of trouble are that the printer, computer, server or other hardware is not correctly set for the network environment you are using, or a printer restriction has been exceeded.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No power</td>
<td>Is the power to the printer turned off? Press the power button to the On position to turn on the power.</td>
</tr>
<tr>
<td></td>
<td>Is the power cord disconnected or not securely connected? Turn off the power to the printer, and connect the power cord to the power outlet again. Then, turn on the power to the printer.</td>
</tr>
<tr>
<td></td>
<td>Is the power cord connected to a power outlet with the correct voltage? Connect the printer exclusively to a power outlet with a suitable voltage and current rating.</td>
</tr>
<tr>
<td></td>
<td>Is the printer connected to an uninterruptable power supply? Turn off the power to the printer, and connect the power cord to a suitable power outlet.</td>
</tr>
<tr>
<td></td>
<td>Is the printer connected to a power strip shared with other high-power devices? Connect the printer to a power strip that is not shared with other high-power devices.</td>
</tr>
<tr>
<td>Cannot print</td>
<td>Is the light of the Ready indicator off? If so, this printer is offline or in the menu setting mode. See Main Components and Their Functions on page 21.</td>
</tr>
<tr>
<td></td>
<td>Is there a message displayed on the control panel? Follow the message to correct the problem. See Control Panel Error Messages on page 135.</td>
</tr>
<tr>
<td>Print job sent but the light of the Ready indicator is not blinking or on</td>
<td>Is the interface cable disconnected? Turn off the power and check the connection of the interface cable.</td>
</tr>
<tr>
<td></td>
<td>Is the protocol configured? Check the port status of the interface. Make sure the protocol settings are correctly configured in CentreWare IS. See the Online Help for CentreWare IS.</td>
</tr>
<tr>
<td></td>
<td>Is the computer environment correctly set up? Check the computer environment, such as the print driver. See Network Basics on page 31.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Reason/Action</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Error indicator is on</strong></td>
<td>Is there an error message displayed on the control panel? Check the displayed message and correct the error.</td>
</tr>
<tr>
<td><strong>Error indicator is blinking</strong></td>
<td>An error that you cannot correct by yourself has occurred. Record the displayed error message or error code, turn off the power, pull out the power plug from the outlet. Refer to the Xerox Support website, <a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a>.</td>
</tr>
<tr>
<td>Light of the <strong>Ready</strong> indicator is on and blinking but there is no print output</td>
<td>There are jobs remaining in the printer. Cancel printing or force the remaining data to be printed. To forcibly print the job, press the <strong>OK</strong> button. To cancel the job, press the <strong>Cancel</strong> button.</td>
</tr>
<tr>
<td>Top section of printed document is missing. The top and side margins are incorrect.</td>
<td>Are the paper tray guides in the correct positions? Set the length guide and the width guides to the correct positions. See <strong>Loading Paper in Trays 2-3</strong> on page 55. Check that the paper size on the print driver or the control panel is correctly set. See the Online Help for the print driver. See <strong>Setting Paper Types and Sizes</strong> on page 50. Check that the margin setting is correct on the print driver. (PCL only) See the Online Help for the print driver.</td>
</tr>
<tr>
<td>Condensation has occurred inside the printer</td>
<td>Turn the printer on, and leave it on, for at least one hour to get rid of the condensation. If the problem continues, refer to the Xerox Support website, <a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a>.</td>
</tr>
<tr>
<td>Paper cannot be fed. Paper jams. Multiple paper are fed. Paper is fed at an angle. Paper is wrinkled.</td>
<td>Is the paper correctly loaded? Load the paper correctly. For labels, transparencies, or envelopes, fan them well to allow air to enter between each sheet before loading. See <strong>Loading Paper in Trays 2-3</strong> on page 55. Is the paper damp? Replace with paper from a new ream. See <strong>Loading Paper in Trays 2-3</strong> on page 55. The paper used is not suitable. Load the correct type of paper. See <strong>About Paper</strong> on page 48. Is the paper tray set correctly? Push the paper tray completely into the printer. Is the printer placed on a flat location? Place the printer on a stable flat surface. Are the paper tray guides set in the correct positions? Set the guides to the correct positions. See <strong>Loading Paper in Trays 2-3</strong> on page 55. Paper is fed more than 1 sheet at a time. Multiple feeding of paper may occur before the sheets of paper loaded in the tray are used up. Remove the paper, fan it, and load again. Replenish paper only when all the sheets of the loaded paper are used up.</td>
</tr>
</tbody>
</table>
## Problems With the Printer

**Phaser® 6280 Printer**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unusual noises</td>
<td>The printer is not level. Reposition the printer on a flat, stable surface.</td>
</tr>
<tr>
<td></td>
<td>The paper tray is not inserted properly. Push the paper tray completely into the printer.</td>
</tr>
<tr>
<td></td>
<td>There is a foreign object inside the printer. Turn off the printer and remove the foreign object. Refer to the Xerox Support website, <a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a>, for assistance.</td>
</tr>
</tbody>
</table>
Enabling Options

If your options are not working, do the following to enable the options:

PostScript Driver
1. To start, do the following:
   - Windows 2000-XP: Click Start > Settings > Printers and Faxes.
   - Windows Vista: Click Start > Printers.
     Right-click the printer and select Properties.
2. Click the Device Settings tab.
3. Under Installable Options, select Available for the option that you want to enable.
4. Click the OK button.

PCL Driver
1. To start, do the following:
   - Windows 2000-XP: Click Start > Settings > Printers and Faxes.
   - Windows Vista: Click Start > Printers.
     Right-click the printer and select Properties.
2. Click the Options tab.
3. Click the option you want to enable to highlight it.
4. In the Settings for field, select Available.
5. Click the OK button.
## Control Panel Error Messages

This section describes the messages displayed on the control panel.

### Messages About Supplies

<table>
<thead>
<tr>
<th>Message</th>
<th>Condition/Reason/Action</th>
</tr>
</thead>
</table>
| 010-351 Replace Fuser | Time to replace the fuser.  
Replace the old fuser with a new one. |
| 010-359 Fuser CRUM Error | The fuser is not installed correctly or is not working correctly due to damage or malfunction. Reinstall the fuser. |
| 010-317 Insert Fuser | The fuser is not installed.  
Install the fuser. |
| XXX*¹ CRUM Error Restart Printer / Error 093 - NNN*² Restart Printer | The XXX print cartridge is not installed correctly or is not working correctly due to damage or malfunction.  
Reinstall the print cartridge. See Checking/Managing the Printer with CentreWare IS on page 145. |
| Check Cartridge XXX Cartridge | Sealing tape is still attached to the XXX print cartridge.  
Remove the sealing tape from the displayed print cartridge. |
| Insert Transfer Unit | The transfer unit is not installed correctly or is not working correctly due to damage or malfunction. Reinstall the transfer unit. |
| Insert XXX Cartridge | The XXX print cartridge is not installed. Install the XXX print cartridge.  
See Checking/Managing the Printer with CentreWare IS on page 145. |
| Insert Transfer Unit | The transfer unit is not installed. Install the transfer unit. |
| Ready to Print %S XXX Low Replace Soon | The XXX print cartridge is nearly empty.  
Purchase a new print cartridge.  
See Checking/Managing the Printer with CentreWare IS on page 145. |
| Ready to Print Transfer Unit Replace Soon | It is nearly time to replace the transfer unit.  
Purchase a new transfer unit. |
| Replace XXX Cartridge | The print cartridge has become empty.  
Replace the old print cartridge with a new one. |
| Replace Transfer Unit | Time to replace the transfer unit.  
Replace the old transfer unit with a new one. |

*¹ XXX indicates one of the following: the Yellow Toner (Y), Cyan Toner (C), Magenta Toner (M), or Black Toner (K).  
*² NNN indicates a numeric value.
### Messages About the Printer and Other Items

<table>
<thead>
<tr>
<th>Message</th>
<th>Condition/Reason/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over Heat Please Wait / Error 042-700 Please Wait</td>
<td>The printer’s internal temperature is too high. The printer has been stopped. Wait 1 hour before restarting the printer. Ensure the printer has adequate cooling space around it, and that the cooling vents are not blocked.</td>
</tr>
<tr>
<td>Tray Missing 024-946 / Tray Missing Insert Tray 2</td>
<td>Tray 2 is pulled out. Push Tray 2 into the correct position.</td>
</tr>
<tr>
<td>Tray Missing 024-947 / Tray Missing Insert Tray 3</td>
<td>Tray 3 is pulled out. Push Tray 3 into the correct position.</td>
</tr>
<tr>
<td>Jam at Tray 1 (MPT), 2, or 3 Check Tray 1 (MPT), 2, or 3 Open Door A</td>
<td>Paper is jammed inside Tray 1 (MPT), 2, or 3. Remove the jammed paper. Open and close the front cover. See Paper Jams on page 116.</td>
</tr>
<tr>
<td>Door A Open Close Door A</td>
<td>The front cover is open. Close the front cover.</td>
</tr>
<tr>
<td>Disabled Function Error 016-158</td>
<td>The user is not registered to print in color when using an authentication function. Contact your administrator.</td>
</tr>
<tr>
<td>Invalid Job Press OK Button Error 016-799</td>
<td>When the configuration of the printer on the print driver does not conform to the printer you are using, this message appears. Press the Cancel button to cancel the print job. Make sure that the configuration of the printer on the print driver conforms to the printer you are using.</td>
</tr>
<tr>
<td>Invalid User Error 016-757</td>
<td>The user is not registered to print on the printer when using an authentication function. Contact the administrator.</td>
</tr>
<tr>
<td>Limit Exceeded Press OK Button</td>
<td>The user has exceeded the limit on the number of pages that can be printed when using an authentication function. Contact the administrator.</td>
</tr>
<tr>
<td>Invalid User Press OK Button</td>
<td>The user is not registered to print on the printer when using an authentication function. Contact the administrator.</td>
</tr>
<tr>
<td>Jam at Duplexer Open Door A Lift Transfer Unit</td>
<td>Paper is jammed inside the printer. Press the button to open the front cover and remove the jammed paper. See Paper Jams on page 116.</td>
</tr>
<tr>
<td>Open Door A Remove Paper &amp; Check Paper Type</td>
<td>Paper is jammed inside the printer. Press the button to open the front cover and remove the jammed paper. Check the paper type. See Paper Jams on page 116.</td>
</tr>
<tr>
<td>Message</td>
<td>Condition/Reason/Action</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Out of Memory Press OK Button Error 016-718 | The printer memory is full and cannot continue processing the current print job. Press the OK button to clear the message, cancel the current print job, and conduct the next print job, if any. Press the Cancel button to cancel the print job. Press the Left Arrow button to open the Walk-Up Features menu and delete the job being held. If the problem has not been corrected, turn the printer off and then on again. To avoid this error in the future, do the following:  
  - Delete unnecessary fonts, macros, and other data in printer memory.  
  - Install additional printer memory. |
| PDL Error Press OK Button Error 016-720 | Error relating to PCL emulation problems has occurred. Press the OK button to clear the message, cancel the current print job, and conduct the next print job, if any. Press the Cancel button to cancel the print job. |
| Disk Full Press OK Button Error 016-982 | RAM disk memory is full and cannot continue processing the current print job. Press the OK button to clear the message, cancel the current print job, and conduct the next print job, if any. Press the Cancel button to cancel the print job. Press the Left Arrow button to open the Walk-Up Features menu and delete the current job. To avoid this error in the future, do the following:  
  - Reduce the number of print pages, such as splitting the print data.  
  - Increase free memory space by deleting unnecessary data in the RAM disk. |
| Ready to Print %S Over Heat Turned Halfmode | The printer’s internal temperature is too high. Processing on the printer has been slowed down. When the internal temperature falls, the processing speed will automatically increase. |
| Ready to Print %S Non-Xerox Toner | The printer is in the custom toner mode. Though some of the print cartridges reach the end of their lives, you can continue printing. |
| Restart Printer 116-NNN3 | Error NNN-NNN relates to printer problems. Turn the printer off and then on. If the error continues, refer to the Xerox Support website, www.xerox.com/office/6280support. |
| 550 Feeder Error Restart Printer / Error 072-215 Restart Printer | The 550-Sheet Feeder (optional) is not installed correctly or is not working correctly due to damage or malfunction. Reinstall the sheet feeder. |
### Control Panel Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Condition/Reason/Action</th>
</tr>
</thead>
</table>
| **Duplexer Error**  
**Restart Printer**  
**Error 072-215**  | The Duplex Unit (optional) is not installed correctly or is not working correctly due to damage or malfunction.  
Reinstall the Duplex Unit. |
| **RAM Error**  
**Restart Printer**  
**Error 116-316**  | Additional memory (optional) is not installed correctly or is not working correctly due to damage or malfunction.  
Reinstall the additional memory. |
| **RAM Error**  
**Restart Printer**  
**Error 116-320**  | An unsupported additional memory (optional) is installed.  
Replace the specified additional memory. |
| **Load Tray 1 (MPT), 2, or 3**  
**<Size> or <Type>**  | The correct paper is not set in Tray xxxx.  
Set the following size, direction, and type of paper into the tray: XXXX.  
xxx indicates the number of the tray or Tray 1 (MPT). See Loading Paper in Trays 2-3 on page 55. |

*3 NNN indicates a numeric value.
Getting Help

This section includes:

- Control Panel Messages on page 139
- PrintingScout Alerts on page 139
- Online Support Assistant on page 139
- Web Links on page 140

Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

Control Panel Messages

The control panel provides you with information and troubleshooting help. When an error or warning condition occurs, the control panel displays a message informing you of the problem.

PrintingScout Alerts

PrintingScout is a tool that is included on the Software and Documentation CD-ROM. It automatically checks the printer status when you send a print job. If the printer is unable to print your job, PrintingScout automatically displays an alert on your computer screen to let you know that the printer needs attention.

PrintingScout is unavailable for Windows Vista.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your printer problems. You can find solutions for print quality, media jams, software installation, and much more.

To access the Online Support Assistant, go to www.xerox.com/office/6280support.
Web Links

Xerox provides several websites that offer additional help on your Phaser 6280 printer. A set of Xerox links is installed in your web browser’s Favorites folder when you install the Xerox printer drivers on your computer.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical support information for your printer, includes online Technical Support, Recommended Media List, Online Support Assistant, driver downloads, documentation, video tutorials, and much more:</td>
<td><a href="http://www.xerox.com/office/6280support">www.xerox.com/office/6280support</a></td>
</tr>
<tr>
<td>Supplies for your printer:</td>
<td><a href="http://www.xerox.com/office/6280supplies">www.xerox.com/office/6280supplies</a></td>
</tr>
<tr>
<td>A resource for tools and information, such as interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs:</td>
<td><a href="http://www.xerox.com/office/businessresourcecenter">www.xerox.com/office/businessresourcecenter</a></td>
</tr>
<tr>
<td>Local sales and support center:</td>
<td><a href="http://www.xerox.com/office/contacts">www.xerox.com/office/contacts</a></td>
</tr>
<tr>
<td>Printer registration:</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
<tr>
<td>Material Safety Data Sheets identify materials, and provide information on safely handling and storing hazardous materials:</td>
<td><a href="http://www.xerox.com/msds">www.xerox.com/msds</a> (U.S. and Canada) <a href="http://www.xerox.com/environment_europe">www.xerox.com/environment_europe</a> (European Union)</td>
</tr>
<tr>
<td>Information about recycling supplies:</td>
<td><a href="http://www.xerox.com/gwa">www.xerox.com/gwa</a></td>
</tr>
</tbody>
</table>
Maintenance

This chapter includes:

- Cleaning the Printer on page 142
- Ordering Supplies on page 143
- Managing the Printer on page 145
- Checking Page Counts on page 149
- Moving the Printer on page 150

See also: Small Business Resource Center at www.office.xerox.com
Cleaning the Printer

This section describes how to clean the printer in order to maintain it in good condition and print clean printouts all the time.

Warning: Be sure to turn off and unplug the printer before accessing the interior of the printer for cleaning, maintenance, or fault clearance. Access to a live printer’s interior can cause electric shock.

Cleaning the Exterior

Clean the exterior of the printer about once a month. Wipe the parts with a wet but well-wrung soft cloth. Then wipe with another dry soft cloth. For stubborn stains, apply a small amount of neutral detergent, and gently wipe the stain off.

Note: Do not spray the detergent directly on the printer. The liquid detergent may enter the printer through a gap and cause problems. Never use cleaning agents other than water or neutral detergent.

Cleaning the Interior

After clearing paper jams or replacing the print cartridge, inspect the inside of the printer before closing the printer covers.

Warning: Never touch a labeled area found on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it by yourself to avoid injuries or burns. Switch off the printer immediately. Refer to the Xerox Support website, www.xerox.com/office/6280support.

- Remove any remaining pieces of paper.
- Remove any dust or stains with a dry clean cloth.
Ordering Supplies

This section includes:

- **Consumables** on page 143
- **Routine Maintenance Items** on page 143
- **When to Order Supplies** on page 143
- **Recycling Supplies** on page 144

Certain consumables and routine maintenance items need to be ordered occasionally. Each supply includes installation instructions.

**Consumables**

Genuine Xerox Print Cartridges (Cyan, Magenta, Yellow, and Black):

- Standard capacity
- High capacity

*Note:* Each print cartridge includes installation instructions on the box.

*Note:* To enhance print quality, print cartridges for many models of equipment have been designed to cease functioning at a predetermined point.

**Routine Maintenance Items**

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements may be parts or kits. Routine maintenance items are typically customer replaceable.

- Fuser
- Transfer unit
- Feed roller kit

**When to Order Supplies**

The control panel displays a warning when the supply nears its replacement time. Verify that you have replacements on hand. It is important to order these supplies when the messages first appear to avoid interruptions to your printing. The control panel displays an error message when the supply must be replaced.
To order supplies, contact your local reseller or go to the Xerox Supplies website at www.xerox.com/office/6280supplies.

**Caution:** Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreements, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside these areas; please contact your local representative for details.

**Recycling Supplies**

For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.
Managing the Printer

This section includes:

- Checking/Managing the Printer with CentreWare IS on page 145
- Checking Printer Status with PrintingScout on page 145
- Checking Printer Status Through E-mail on page 146

Checking/Managing the Printer with CentreWare IS

When the printer is installed in a TCP/IP environment, you can check printer status and configure settings using a web browser on a network computer. You can also use CentreWare IS to check the remaining volume of consumables and the paper loaded in this printer.

Note: When using the printer as a local printer, you cannot use CentreWare IS. For details about checking the status of a local printer, refer to Checking Printer Status with PrintingScout on page 145.

The following browsers can be used with CentreWare IS:

- Netscape 7 or later
- Internet Explorer version 5 or later

Starting CentreWare IS

Use the following procedure to start CentreWare IS.

1. Launch your web browser.
2. Enter the printer’s IP address in the browser’s Address field (http://xxx.xxx.xxx.xxx).
   The CentreWare IS screen appears.

Using Online Help

For details regarding the items that can be set in each CentreWare IS screen, click the Help button to display the Online Help.

Note: Clicking the Help button displays the online manual on the Xerox website.

Checking Printer Status with PrintingScout

PrintingScout is a tool that is installed with your Xerox printer driver. It automatically checks the printer status when you send a print job. PrintingScout can check the paper size that is loaded into the trays, the status of the output tray, and the remaining amount of consumables, such as print cartridges.

Starting PrintingScout

Double-click the PrintingScout icon on the task bar or right-click the icon and select Select Printer.
If the PrintingScout icon is not displayed on the task bar, open PrintingScout from the Start menu:

1. From the **Start** menu, select **Programs**, then **Xerox Office Printing**, then **PrintingScout**, and then **Activate PrintingScout**.
2. The **Select Printer** screen appears.

For details about the functions of PrintingScout, refer to the Online Help.

**Checking Printer Status Through E-mail**

When connected in a network environment where sending and receiving of e-mail is possible, the printer can send an e-mail report to specified e-mail addresses containing the following information:

- The network settings and the printer status
- The error status which has occurred on the printer

**Setting the E-mail Environment**

Activate CentreWare IS, and on the **Properties** tab, configure the following settings according to your e-mail environment. After configuring the settings on each screen, always click **Apply** and turn off/on the printer to reboot. For details about each item, refer to the Online Help for CentreWare IS.

<table>
<thead>
<tr>
<th>Item</th>
<th>Item to be configured</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail Alerts</td>
<td>SysAdmin E-mail Address</td>
<td>Set the e-mail address to which notices about changes in printer status or errors are sent.</td>
</tr>
<tr>
<td></td>
<td>Notification Items</td>
<td>Set the contents of the notices to send in the e-mail.</td>
</tr>
<tr>
<td>Port Status</td>
<td>StatusMessenger</td>
<td>Select Enable.</td>
</tr>
</tbody>
</table>
Checking the Printer Status with E-mail

This section describes cautions when sending e-mail to the printer to check the printer status.

- You can specify any title for the e-mail when checking the printer status or changing the printer settings.
- Use the commands described in the next section to create the text of the e-mail.
Commands That Can Be Used in E-mail Text

Use each command according to the following rules.

- Prefix all commands with “#”, and specify the #Password command at the top of the e-mail.
- Command lines without “#” are ignored.
- Write one command on each line and separate each command and parameter with a space or a tab.

When the same command is written two or more times in one e-mail, the second and subsequent commands are ignored.

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Password</td>
<td>Password</td>
<td>Use this command at the top of the e-mail when a password for read only or full access is set. You can omit this command when the password is not set.</td>
</tr>
<tr>
<td>#NetworkInfo</td>
<td></td>
<td>Set this when you want to check information on the network settings list.</td>
</tr>
<tr>
<td>#Status</td>
<td></td>
<td>Set this when you want to check the printer status.</td>
</tr>
<tr>
<td>#SetMsgAddr</td>
<td>Recipient E-mail address</td>
<td>Use this command to specify the e-mail address to which e-mail reports are sent to. This command can only be used when the full access password is specified by the #Password command.</td>
</tr>
</tbody>
</table>

Example of Commands

1. When the read only password is “ronly”, and to check the printer status:
   - #Password ronly
   - #Status

2. When the full access password is “admin”, and to set the recipient e-mail address to “service@xerox.com”:
   - #Password admin
   - #SetMsgAddr service@xerox.com

3. When the full access password is “admin”, and to set the recipient e-mail address to “service@xerox.com”, then confirm the setting result on the network settings list:
   - #Password admin
   - #SetMsgAddr service@xerox.com
   - #NetworkInfo

Note: Describe the “#SetMsgAddr” command before the “#NetworkInfo” command. If they are written in reverse, the information retrieved by the “#NetworkInfo” command and the result of executing the “#SetMsgAddr” command may differ.
Checking Page Counts

The total number of printed pages can be checked at the control panel. Three meters are available: Total Impressions, Color Impressions, and Black Impressions.

The billing meter counts the number of pages printed properly. Single side print (including N-up) is counted as one impression, and 2-sided print (including N-up) is counted as two. During duplex printing, if an error occurs after one side is printed properly, it is counted as one.

When printing color data, that has been converted by using ICC profile on an application, with the Color (Auto) setting, the data is printed by color even if it seems to be black and white data on the monitor. In that case, Color Impressions is increased.

**Note:** Grayscale images printed with the composite black setting count as color pages, because color consumables are used. This is the default setting on most printers.

When doing 2 sided printing, a blank page may be inserted automatically depending on the settings on the application. In this case, the blank page is counted as one page.

Use the following procedure to check a meter:

1. Press the **Menu** button.
2. Press either the **Up Arrow** or **Down Arrow** button until **Billing Meter** is displayed, and then press the **Forward Arrow** or **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button until the desired meter is displayed.
4. After checking, press the **Menu** button.
Moving the Printer

Carry out the following procedure when moving the printer.

To view precautions and guidelines for safely moving your printer, see User Safety on page 8.

The printer, configured with the optional accessories, paper trays, and consumables, weighs 24.5 kg (54 lb.).

When moving the equipment, make sure that there are two or more persons carrying it.

When lifting the printer, be sure to observe the following points. Failure to do so may cause the printer to fall and result in injuries.

Two persons, one facing the front of the printer (control panel) and the other facing the back, should firmly grip the recessed areas on the bottom part of both sides of the printer. Never try to lift the printer by gripping any other areas.

**Warning:** If the 550-Sheet Feeder (optional) has been installed, uninstall it before moving the printer. If these are not fixed securely to the printer, they may fall to the ground and cause injuries. For details on how to uninstall the options, refer to the instructions sheet that is bundled with each option.

**Note:** The front side of this printer is heavier than the rear. Take note of this difference in weight when moving the printer.
1. Turn off the printer.

2. Disconnect the power cord, interface cable, and any other cables.

**Warning:** To prevent electric shock, never touch the power plug with wet hands. When removing the power cord, make sure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead to fire or electrical shock.
3. Remove any paper in the output tray and return the paper stopper to its original position.

4. Remove any paper in the Tray 1 (MPT), and then close the front cover. Keep the paper wrapped and away from humidity and dirt.
5. Pull out the paper tray from the printer and remove any paper in the tray, and then reinstall the tray. Keep the paper wrapped and away from humidity and dirt.

6. Lift the printer and move it gently.

   **Note:** If the printer is to be moved over a long distance, the print cartridges should be removed to prevent toner from spilling and the printer should be packed inside a box.

7. After transporting the printer, adjust the color registration before using it.

   *See also:*
   - Color Registration on page 111
Index

Numerics
2-sided printing, 66
  automatic, 66
  binding edge options, 67
  selecting, 67

A
AutoIP
  manually setting the printer’s IP address, 37
  setting the printer’s IP address dynamically, 36
automatic
  2-sided printing, 66
available printer drivers, 39

B
billing meters, 96
  total printed pages, 149
binding edge printing options, 67

C
cautions symbols, 13
CentreWare IS
  changing or modifying the printer’s IP address, 38
  checking status, 28
  enabling DHCP, 36
  managing printer, 145
  online help for, 145
  setting the printer’s IP address dynamically, 36
  starting, 145
changing the IP address using CentreWare IS, 38
checking printed pages
  how to check the meter, 149
choosing a network connection, 33
cleaning
  printer, 142

printer exterior, 142
printer interior, 142

clearance
  location of the printer, 10
color registration
  adjusting, 111
  automatic adjustment, 111
  determining values, 112
  enabling/disabling automatic adjustment, 113
  entering values, 112
  manual adjustment, 111
  printing the correction chart, 111
configuration
  optional accessories, 29
connection
  Ethernet, 33
  USB, 34
consumables, 143
  error messages, 135
control panel, 25
  Configuration page, 26
  display, 25
  error messages, 135
  information pages, 26
  layout, 25
  Menu Map, 26
  menus, 91
  messages, 139
control panel menus
  changing settings, 92
  control panel, 104
description of, 93
information pages, 95
maintenance mode, 101
system settings, 98
tray settings, 93
custom paper
  defining size
    with PCL driver, 83
    with PostScript driver, 84
custom size paper, 83
Index

printing from Tray 1 (MPT), 84
supported for Tray 1 (MPT), 83

D

DHCP
  enabled by default on Phaser printers, 36
  enabling on the control panel, 36
  enabling with CentreWare IS, 36
  manually setting the printer’s IP address, 37
  setting the printer’s IP address dynamically, 36
drivers
  available, 39
  description, 39
  installing, 39
  Macintosh, 39
  Macintosh OS X version 10.3, 41
  Macintosh OS X version 10.4, 43, 44
  PCL, 39
  PostScript, 39
  selecting 2-sided printing, 67
  UNIX/Linux, 39
  Windows 2000 or later, 40
duplex unit, 24
dynamically setting the printer’s IP address, 36

E

electrical safety, 8
e-mail
  commands for, 148
  enabling
    options, 134
  enabling AutoIP on the printer, 36
  enabling DHCP on the printer, 36
  envelopes, 70
  guidelines, 70
  printing from Tray 1 (MPT), 72
error and warning messages, 139
error messages
  about consumables, 135
  control panel, 135
  Ethernet connection, 33

G

glossy paper, 78
  printing from Tray 1 (MPT), 78
  printing from Trays 2-3, 80
  printing guidelines, 78
guidelines
  automatic 2-sided printing, 66
  envelopes, 70
  glossy paper, 78
  labels, 73
  operational, 10
  paper storage, 48
  paper usage, 46
  printing on both sides of the paper, 66
  printing safety, 11

H

help
  resources, 30
how to check the meter, 149

I

information
  about your printer, 30
  information pages, 30
  Installation Guide, 30
  printer management tools, 30
  Quick Use Guide, 30
  resources, 30
  technical support, 30
  video tutorials, 30
  web links, 30
information pages, 26
  Configuration, 26
  control panel menu, 95
  Menu Map, 26
installing printer drivers, 39
  Mac OS X, version 10.3, 41
Mac OS X, version 10.4, 43, 44
Windows 2000 or later, 40
IP address
changing or modifying using CentreWare IS, 38
dynamically setting, 36
setting manually, 37

J
job
individual printing options
Macintosh, 63
Windows, 61
selecting printing options
Windows, 61

L
labels, 73
guidelines, 73
printing from Tray 1 (MPT), 73
printing from Trays 2-3, 75
laser safety, 9
loading paper
Tray 1 (MPT), 53
Trays 2-3, 56
Local Area Network (LAN), 35
location of the printer, 9
long paper, 83

M
Macintosh
PostScript driver settings, 63
selecting printing options for an individual job, 63
Macintosh OS X version 10.3
printer drivers, 41
Macintosh OS X version 10.4, 43, 44
maintenance
ordering supplies, 143
routine maintenance items, 143
safety, 9
maintenance mode, 101
managing printer, 145
manually setting the printer’s IP address, 37
overrides AutoIP, 37
overrides DHCP, 37
media
supported, 46
unacceptable types, 48
memory, 24
Menu Map, 26, 105
menu settings
changing, 92
Tray 1 (MPT), 94
menus
common tray settings, 93
tray settings, 93
messages
control panel, 139
PrintingScout, 139
meters
total page counts, 149
mode
power saver, 27
exiting, 27
modifying the IP address using CentreWare IS, 38
moving
printer, 150

N
network
choosing a network connection, 33
creating a Local Area Network (LAN), 35
setup and configuration, 32
TCP/IP and IP addresses, 35
network connection, 33
Ethernet, 33

O
Online Support Assistant, 139
operating systems
printer drivers, 39
operational guidelines, 10
operational safety, 9
options
Index

550-sheet feeder, 24
duplex unit, 24
enabling, 134
memory, 24
multi-protocol card, 24
printer, 24
printing, 60
ordering supplies, 143

P
paper
custom sizes, 83
damaging to the printer, 48
duplex unit, 24
enabling, 134
memory, 24
multi-protocol card, 24
printer, 24
printing, 60
ordering supplies, 143

PCL, 39
PostScript, 39
power saver mode, 27
pre-printed paper, 53
print quality
problems, 107
print status
checking, 28
printer
cautions, 13
changing or modifying the IP address
using CentreWare IS, 38
cleaning, 142
cleaning the exterior, 142
cleaning the interior, 142
clearance, 10
drivers, 39

enabling AutoIP, 36
enabling DHCP, 36
front view of, 21
information resources, 30
internal parts, 22
location, 9
main parts of, 21
managing, 145
moving, 150
options, 24
rear view of, 22
registration, 140
supplies, 11
printer driver
available, 39
installing, 39
Layout tab, 61
Macintosh, 39
Macintosh OS X version 10.3, 41
Macintosh OS X version 10.4, 43, 44
operating systems, 39
Output Options tab, 61
page description languages, 39
Paper/Quality tab, 61
PCL, 39
PostScript, 39
UNIX/Linux, 39
Windows 2000 or later, 40
printer status
checking via e-mail, 147
PrintingScout, 145
Status Messenger, 146
printing
2-sided, 67
automatic 2-sided, 66
binding edge options, 67
custom paper
with PCL driver, 84
with PostScript driver, 85
custom size or long paper, 83
duplex unit, 24
enabling, 134
envelopes, 70
with PCL driver, 72
with PostScript driver, 72
glossy paper, 78
labels, 73
Layout tab, 61
on both sides of the paper, 66
options
Macintosh, 63
  selecting, 61, 63
Windows, 61
Output Options tab, 61
Paper Quality tab, 61
safety guidelines, 11
selecting 2-sided, 67
selecting individual job printing options
  Macintosh, 63
  Windows, 61
selecting options, 60
selecting printing preferences
  (Windows), 60
transparencies, 68
  with PCL driver, 70
  with PostScript driver, 69
two-sided pages, 66
printing confidential document
  secure print, 86
PrintingScout
  alerts, 139
  printer status, 145
proof print, 88

R
recycling supplies, 144
registering your printer, 140
regulatory information
  Canada, 15
  Europe, 16
  United States, 15
resources
  information, 30
  routine maintenance items, 143
run black, 114

S
safety
  electrical, 8
  laser, 9
  maintenance, 9
  operational, 9
printing guidelines, 11
symbols, 13
safety symbols marked on product, 13
secure print, 86
selecting
  2-sided printing, 67
  printing options, 60
  printing options for an individual job
    Macintosh, 63
    Windows, 61
  printing preferences (Windows), 60
setting
  printer’s IP address dynamically, 36
  printer’s IP address manually, 37
setting up the network, 32
specialty media, 68
  custom size paper, 83
  envelopes, 70
  glossy paper, 78
  labels, 73
  long paper, 83
  transparencies, 68
Status Messenger
  checking printer status, 146
  commands, 148
  configuring, 146
supplies, 11
  ordering, 143
  recycling, 144
  when to order, 143
supported paper and media, 46
supported paper sizes and weights
  Tray 1 (MPT), 49
  Trays 2-3, 49
system settings, 98

T
TCP/IP addresses, 35
technical support, 30
transparencies, 68
  guidelines, 68
  printing from Tray 1 (MPT), 69
Index

Tray 1 (MPT)
loading paper, 53
printing custom size paper, 84
printing envelopes, 72
printing glossy paper, 78
printing labels, 73
printing transparencies, 69
settings, 94

trays
additional, 24
common settings, 93
options, 24

Trays 2-3
loading paper, 56
printing glossy paper, 80
printing labels, 75

troubleshooting
technical support, 30
turning off the printer, 12
two-sided printing, 66
automatic, 66
binding edge options, 67
selecting, 67

U
unacceptable paper and media, 48
usage guidelines
paper, 46
USB, 34

W
warning and error messages, 139
web links, 140
information, 30
website resources, 140
Windows
install printer drivers for Windows 2000 or later, 40
printing options, 61
selecting printing options for an individual job, 61
Windows PostScript driver, 39

X
Xerox
supplies recycling programs, 144

website resources, 140